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Safety Guidelines

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

| AADANGER

indicates that death or severe personal injury will result if proper precautions are not taken.

AAWARNING

indicates that death or severe personal injury may result if proper precautions are not taken.

A\CAUTION
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

NOTICE

indicates that an unintended result or situation can occur if the corresponding information is not taken into
account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes
in this documentation qualified persons are defined as persons who are authorized to commission, ground and
label devices, systems and circuits in accordance with established safety practices and standards.

Prescribed Usage

Trademarks

Note the following:

AAWARNING

This device may only be used for the applications described in the catalog or the technical description and only
in connection with devices or components from other manufacturers which have been approved or
recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage,
positioning and assembly as well as careful operation and maintenance.

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the
owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the
information in this publication is reviewed regularly and any necessary corrections are included in subsequent
editions.

Siemens AG Ordernumber: 6AV6691-1BA01-3AB0O Copyright © Siemens AG 2008.
Industry Sector ® 07/2008 Technical data subject to change
Postfach 48 48

90327 NURNBERG

GERMANY
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Purpose of this manual

This user manual is part of the WinCC flexible documentation.. The manual provides you
with a comprehensive overview of working in WinCC flexible Runtime. The manual supports
you in simulating new projects on your programming computer, in transferrring a project to
an HMI device and in working with WinCC flexible Runtime.

The readership addressed by this manual are newcomers, system migrators, operators and
engineers who are concerned with operation, configuration, commissioning and service
tasks using WinCC flexible.

Basic Knowledge Requirements

General knowledge in the field of automation engineering is required to understand this
manual.

You should also have experience of using PCs running under the Windows 2000 or
Windows XP operating systems.

Scope of the manual
This manual applies to the WinCC flexible 2008 Runtime software package.

Position in the information scheme

This manual is part of the SIMATIC HMI documentation. The information below presents an
overview of the information landscape of SIMATIC HMI.

User manual
® WinCC flexible Micro

— describes the engineering basics based on the WinCC flexible Micro engineering
system (ES)

® WinCC flexible Compact/ Standard/ Advanced

— describes the engineering basics based on the WinCC flexible Compact,
WinCC flexible Standard and WinCC flexible Advanced engineering systems (ES)

® WinCC flexible Runtime:

— Describes how to commission and operate your Runtime project on a PC.

WinCC flexible 2008 Runtime
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® WinCC flexible Migration:

Describes how to convert an existing ProTool project to WinCC flexible.
Describes how to convert an existing WinCC project to WinCC flexible.

Describes how to migrate ProTool projects with an HMI migration from OP3 to OP 73
or OP 73 micro.

Describes how to migrate ProTool projects with an HMI migration from OP7 to OP 77B
or OP 77A.

Describes how to migrate ProTool projects with an HMI migration from OP17 to
OP 177B.

describes how to migrate ProTool projects with HMI migration from RMOS graphic
devices to Windows CE devices.

® Communication:

Communication Part 1 describes the connection of the HMI device to SIMATIC PLCs.

Communication Part 2 describes the connection of the HMI device to third-party PLCs.

Operating Instructions

® Operating instructions for SIMATIC HMI devices:

OP 73,0P 77A, OP 77B

TP 170micro, TP 170A, TP 170B, OP 170B
OP 73micro, TP 177micro

TP 177A, TP 177B, OP 177B

TP 270, OP 270

MP 270B

MP 377

® Operating instructions for mobile SIMATIC HMI devices:

Mobile Panel 170
Mobile Panel 277
Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN

e QOperating instructions (compact) for SIMATIC HMI devices:

OP 77B
Mobile Panel 170

Getting Started
® WinCC flexible for first time users:

Based on a sample project, this is a step-by-step introduction to the basics of
configuring screens, alarms, and recipes, and screen navigation.

o WinCC flexible for advanced users:

Based on a sample project, this is a step-by-step introduction to the basics of
configuring logs, project reports, scripts, user management, and multilingual projects,
and integration into STEP 7.

WinCC flexible 2008 Runtime
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® WinCC flexible options:

— Based on a sample project, this is a step-by-step introduction to the basics of
configuring the WinCC flexible Audit, Sm@rtServices, Sm@rtAccess and OPC Server
options.

Online availability

The following link actively guides you to technical documentation for SIMATIC products and
systems in different languages.

o SIMATIC Guide Technical Documentation:

http://www.automation.siemens.com/simatic/portal/html_76/techdoku.htm

Guide
Structure of this manual:
® Introduction to WinCC flexible Runtime — Chapters 1-3
o Commissioning WinCC flexible Runtime — Chapter 4
® Operating in Runtime — Chapters 5-6
® Appendix— Chapter 7
Conventions

This documentation uses the term "HMI device" for all systems operating with WinCC flexible
Runtime.

A distinction is made in the naming conventions for the configuration and runtime software:
® "WinCC flexible" refers to the configuration software.
® "Runtime" designates the runtime software running on the HMI devices.

® "WinCC flexible Runtime" designates the visualization product for use on standard PCs or
panel PCs.

The term "WinCC flexible" is used in the general context. A version name such as
"WiInCC flexible 2008" is used whenever it is necessary to distinguish it from other versions.

The following formatting is used to facilitate reading of the manual:

Notation Scope

"Add screen” e Terminology that occurs in the user interface, e.g., dialog
names, tabs, buttons, menu commands.

e Inputs required, e.g., limit values, tag values
e Path information

"File > Edit" Operational sequences, e.g., menu commands/shortcut menu
commands.
<F1>, <Alt + P> Keyboard inputs

WinCC flexible 2008 Runtime
User's Manual, 07/2008, 6AV6691-1BA01-3AB0 5


http://www.automation.siemens.com/simatic/portal/html_76/techdoku.htm

Preface

Trademarks

Please observe notes labeled as follows:

Note

Notes containing important information about the product and its use or a specific section of
the documentation to which you should pay particular attention.

HMI®

SIMATIC®

SIMATIC HMI®

SIMATIC ProTool®
SIMATIC WinCC®
SIMATIC WinCC flexible®

Third parties using for their own purposes any other names in this document which refer to
trademarks might infringe upon the rights of the trademark owners.

Additional support

Representatives and offices

Training center

If you have questions concerning the use of the described product which are not answered in
this manual, please contact the Siemens representative in your area.

Find your contact partner at:
http://www.siemens.com/automation/partner

A guide to the technical documentation for the various SIMATIC products and systems is
available at:

http://www.siemens.com/simatic-tech-doku-portal
The online catalog and the online ordering system is available at:

http://mall.automation.siemens.com

To familiarize you with automation systems, we offer a variety of courses. Please contact
your regional training center or the central training center in D-90327 Nuremberg, Germany.

Phone: +49 (911) 895-3200

Internet: http://www.sitrain.com

WinCC flexible 2008 Runtime
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Technical support
You can reach the technical support for all A&D products
via the support request form on the web:
http://www.siemens.com/automation/support-request
Phone: + 49 180 5050 222
Fax: + 49 180 5050 223
Additional information about our technical support is available in the Internet at:

http://www.siemens.com/automation/service

Service & support on the Internet
In addition to our documentation, we offer our complete knowledge base on the Internet at.
http://www.siemens.com/automation/service&suppori
There you will find:
® The newsletter which provides the latest information on your products.

e Relevant documentation for your application, which you can access via the search
function in our service & support database.

e A forum where users and experts from all over ther world exchange ideas.
® You local Automation & Drives representative.

e Information about on-site service, repairs, spare parts. And lots more under "Services".

WinCC flexible 2008 Runtime
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WinCC flexible Runtime 1

Principle

In runtime, the operator can control and monitor the process. This involves in particular the
following tasks:

o Communication with the automation systems.
® On-screen visualization of images

® Operating the process, for example, by setting setpoint values or opening and closing
valves.

® Archiving of current runtime data, e.g. process values and alarm events.

Performance spectrum of WinCC flexible Runtime

WinCC flexible Runtime supports a certain number of process variables (Powertags) which
is determined by your license:

e WinCC flexible Runtime 128: Supports 128 process variables
® WinCC flexible Runtime 512: Supports 512 process variables
e WinCC flexible Runtime 2048: Supports 2048 process variables

You can increase the number of process variables with a PowerPack.

WinCC flexible 2008 Runtime
User's Manual, 07/2008, 6AV6691-1BA01-3AB0 13
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Introduction to WInCC flexible Runtime 2

Introduction

WinCC flexible Runtime is a high-performance and comprehensive software for the
visualization of processes in projects you created with the WinCC flexible Advanced
programming software.

Modern automation concepts are extremely demanding on process visualization. Process
control close to machines must in particular meet the demands for simple, high-performance
control of the processes. The goal is to present process data to the operator quickly and
clearly in a form that can be easily understood, such as a trend display. This increasingly
requires process displays that simplify understanding of the actual process. It is also
becoming more important to be able to archive the data, e.g. for quality control. This makes it
necessary to log process data at machine level.

WinCC flexible Runtime is designed for visualization and operation of machines and small
systems. The Runtime software has a window-based pixel-graphics user interface. Due to its
short response times, the software features secure process operation, jogging at the
machine and secure data acquisition.

Licensing

If you install the WinCC flexible Runtime software on a standard PC or a panel PC, you will
require a license for unrestricted use. WinCC flexible Runtime runs in a non-licensed mode if
the licensing is missing.

® PC: The license is supplied with WinCC flexible Runtime.

® Panel PCs: The license and WinCC flexible Runtime are supplied with the device.

Components of WinCC flexible

The configuration software WinCC flexible Advanced is used to create your project data on a
PC or PG that is operating on a Windows platform.

The process visualization software WinCC flexible Runtime is used to run the user program
under Windows and to visualize the process. WIinCC flexible Runtime is also used on the
configuration computer to test and simulate the compiled project file.

There are also a number of options with enhanced functions available for WinCC flexible
Runtime. These can be ordered separately as required.

WinCC flexible 2008 Runtime
User's Manual, 07/2008, 6AV6691-1BA01-3AB0 15
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Virus scanner in Runtime

16

An active virus scanner will increase system load, and may lead to disturbances in Runtime.

Always disable the virus scanner when you install an application. An active virus scanner
may also cause operational disruptions of hardware expansions. Running WinCC flexible
can cause a blockade of the modules for process linking. This fact disqualifies in particular
dynamic virus protection via gatekeeper mechanisms.

Always run virus tests in offline mode, and then restart the computer before you enable
process coupling.

Any automatic update of virus scanners initiated on the network may cause unnecessary
load on the system. Always run virus scanner updates in offline mode, and then restart the
computer before you enable process coupling.

WinCC flexible 2008 Runtime
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Functional scope 3

Dependencies of the functions

The functional scope of WinCC flexible Runtime depends on the following conditions:

Range of functions

Hardware of the HMI device

The functionality is determined by the features of the HMI device used, such as memory
capacity and the number of function keys.

Licensing / licensing model

The scope of functions and performance is determined by the licensing and the licensing
model, for example, with respect to the number of tags (power tags).

Runtime options

You can access additional functions by installing the options (e.g. remote access using
the Sm@rtClient display).

Functionality of WinCC flexible Runtime:

Convenient process visualization on a Windows-type user interface

Large selection of standard I/O fields, bars, trend displays, vector graphics and buttons
Integrated alarm system

Dynamic positioning of objects

Archiving of alarms and process values

Recipes

Visual Basic Script for user functions

Standard couplings to SIMATIC S7, SIMATIC S5 and SIMATIC 505 as well as to PLCs
from other manufacturers

HTML Browser
Input protection by means of user groups, passwords and log off times

Remote access using the Sm@rtClient view

WinCC flexible 2008 Runtime
User's Manual, 07/2008, 6AV6691-1BA01-3AB0 17
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System prerequisites

System requirements for PCs

If you wish to run WinCC flexible Runtime on a PC, it must meet the following system

requirements:

Released operating systems
e Windows XP Professional SP2
e Windows XP Professional SP3
® Windows XP Embedded

Only for the approved platforms, such as Panel PC 477.

For information on this, refer to the operating manual for the target platform.

® \Windows Vista Business 32-bit
o Windows Vista Ultimate 32-bit

System requirements

Operating system

"http://www.Adobe.com/"

RAM 128 MB, 512 MB recommended Windows XP
min. 1 GB Windows Vista
Processor min. 300 MHz, Windows XP
Pentium Il or similar processors with
500 MHz recommended
min. 1 GHz Windows Vista
Graphic controller SVGA Windows XP
min. 1024 x 768 to 1600 x 1200 Windows Vista
Hard disk min. 250 MB Windows XP
Free memory space Make allowances for additional free Windows Vista
hard disk space required for the page
file, for example. For further
information, refer to your Windows
documentation.
To view documents in PDF format Adobe Acrobat Reader 5.0 or higher Windows XP
Visit the Adobe homepage at Windows Vista

More powerful processors, as of Pentium IV, may be necessary in connection with Options.

When operating the configuration PC as access point to the process (Panel PC with WinCC

flexible Runtime) set all performance schemes to unlimited continuous operation.

WinCC flexible 2008 Runtime
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System prerequisites

Note
"Aero Glass Style" of Microsoft Vista

"Aero Glass Style" requires a powerful graphics card. Requirements are DirectX9 capability
and a separate 128MB graphics memory.

The performance power of the graphics system architecture can significantly impact the
performance of WinCC flexible.

For WinCC flexible Runtime licensing you must have access to a USB memory device. The
license can also be transferred via network connection. The term storage location generally
denotes the location to which the License Keys are saved.

Note
Maximum number of files in the root directory of memory cards or internal flash

The capacity of the root directory on a memory card or internal flash memory is limited to
256 files. This limit does not apply to subdirectories.

Runtime behavior in Windows XP

Operating system Windows XP or higher provides a Data Execution Prevention (DEP)
function. Deactivate DEP to allow the successful start of WinCC flexible Runtime or add
WinCC flexible Runtime to an exception list. Check the settings by double-clicking the
"System" entry in the Control Panel of the operating system. The "System Properties" dialog
opens. Select the "Advanced" tab in the system properties and click "Settings" in the
"Performance"” section. The "Performance Options" dialog box opens. Select the "Data
Execution Prevention" tab.

The "Turn on DEP for essential Windows programs and services only" is selected by default
and WInCC flexible Runtime can be started.

WinCC flexible Runtime must be added to the exception list if the "Turn on DEP for all
programs and services except those selected" is selected. Click the "Add" button and
navigate to the WinCC flexible installation directory, e.g. <C:\Program
Files\Siemens\SIMATIC WinCC flexible\WinCC flexible 2008 Runtime>. Select the file
"HmiRTm.exe" and confirm your selection with "OK". Close the dialog boxes and restart the
station.

Note

You can also set the DEP options "AlwaysOn" or "AlwaysOff" in the Boot.ini of Windows.
The exception list is no longer valid if "AlwaysOn" is selected. This setting prevents the start
of WinCC flexible Runtime.

For additonal information on DEP, refer to the Windows help and the Microsoft homepage.

WinCC flexible 2008 Runtime
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5.1 Installing WinCC flexible Runtime

Supported devices

WinCC flexible Runtime will run on the following Windows-based systems:
Standard PC
SIMATIC Panel PCs: PC 670, PC 677, PC 870, PC 877, PC IL 70, PC IL 77
SINUMERIK Panel PCs: OP 010, OP 012, OP 015, OP 015A, TP 012, TP 015A
SIMOTION Panel PCs: P012K, P012T, P015K, P012T, PC-R Key, PC-R Touch

Installation on the PC
Install System WinCC flexible Runtime on your system, if you have not done that yet.
Install WinCC flexible Runtime from the "WinCC flexible Runtime" CD.

Note

Do not install the Runtime software from the product DVD of the WinCC flexible Engineering
System. The Runtime software on the product DVD is intended for simulation within the
Engineering System only.

A license (license key) is required to run the Runtime software.

NOTICE

WinCC flexible Runtime runs in demo mode only if you do not have a license. In demo
mode, you are prompted to acknowledge specific messages at regular intervals.

1. Install the runtime software from the CD.

If the autorun function is enabled for your CD-ROM drive, the CD browser is run
automatically when the CD is inserted. Otherwise, run Setup by selecting
"WinCCflexible\Runtime\setup.exe" from the CD.

Select the user interface language of the Setup program under "Language.”
Select "Installation”, then run the "WinCC flexible Runtime" setup.

Follow the setup instructions on the screen.

o M w0 Db

Install the license when you are prompted to do so.
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5.2 Electrical installation

Note

If, when installing the Runtime software, you do not have a license, you can install this
later using the Automation License Manager. The Automation License Manager is
automatically installed during the WinCC flexible installation.

Starting Runtime

OP 73micro, TP 170micro and TP 177micro HMIs cannot write values to the PLC after the
start of Runtime unless the connection to the PLC is up. Any previously initiated write
requests are not executed. This also applies to the "ScreenNumber" area pointer and to the
"SetValue" functions of the "Build screen" event of the start screen.

52 Electrical installation

Connecting the PC to the controller

The PC is connected to the controller via a communciation processor or via the COM1 to
COM4 ports. Please refer to the hardware description from the manufacturer for the proper

electrical installation of your PC.

The table below shows the use of the interfaces:

Controller

PC interface

SIMATIC S5 over AS511

COM1 to COM4 6)
requires an RS232/TTY adapter

SIMATIC S5 via PROFIBUS DP "

via CP CP 5511, CP 5512, CP 5611

SIMATIC S7 via PPI

via CP CP 5511, CP 5512, CP 5611, CP 5613, CP 5614
via PC/PPI adapter 2

SIMATIC S7 via MPI

via CP CP 5511, CP 5512, CP 5611, CP 5613, CP 5614
via PC/MPI adapter 3

via PC adapter USB 3
via Teleservice V5.1

SIMATIC S7 via PROFIBUS DP 4

via CP CP 5511, CP 5512, CP 5611, CP 5613, CP 5614

SIMATIC S7 -PROFINET
(Ethernet (TCP/IP)

via CP CP 1512, CP 1612, CP 1613

SIMATIC 500/505 - NITP

COM1 through COM4 (depending on arrangement)

SIMATIC 500/505 - PROFIBUS DP

via CP CP 5511, CP 5512, CP 5611

SIMATIC HMI HTTP Protocol

Ethernet 5)

OPC

Ethernet network cards

Allen Bradley via DF, DH+, DH485

COM1 through COM4, depending on arrangement

Allen-Bradley Ethernet IP

Ethernet

LG GLOFA-GM

COM1 through COM4, depending on arrangement

Mitsubishi FX

COM1 through COM4, depending on arrangement
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5.3 Connection fo the controller

Controller PC interface

Mitsubishi P4 COM1 through COM4, depending on arrangement
Modicon Modbus RTU COM1 through COM4, depending on arrangement
Modicon Modbus TCP/IP Ethernet

Omron COM1 through COM4, depending on arrangement
Telemecanique — not supported

) WinCC flexible Runtime is passive node (DP slave)

2) Point-to-point connection with S7-200 only, no configuration transfer

3) Point-to-point connection with S7-300 or S7-400 only

4) WinCC flexible Runtime is active node

5 WinCC flexible Runtime must be installed on the devices

6COM2 is blocked for the following devices:

PC 477 12" Touch_1.2.0.0
PC 477 15" Touch_1.2.0.0
PC 477 12" Key_1.2.0.0
PC 477 15" Key_1.2.0.0

5.3 Connection to the controller

Connection to the controller

Connect you HMI device to the controller in order to allow you to simulate your project online
with the controller. You can also test the project by calling the simulator. In this case, you do
not need an online connection to the controller.

Setting the PG / PC interface

PROFIBUS DP communication

1.

o > 0N

Select "Start > Settings > Control Panel", then select "Set PG/PC interface."
Select PROFIBUS under used module parameters.

Click "Properties". The DP profile is selected in the network parameters.
Select universal (DP/FMS), then confirm with OK.

Click "Properties" again.

Select the DP profile again, then confirm with OK.

WinCC flexible 2008 Runtime
User's Manual, 07/2008, 6AV6691-1BA01-3AB0 23



Setting up WinCC flexible Runtime

5.4 Settings of the Runtime software

MPI communication

5.4

Principle

24

1. Select "Start > Settings > Control Panel", then select "Set PG/PC interface."

2. Click "Properties", then set the parameters on the MPI network tab for the HMI device so
that this is the only master on the bus.

Only one of several HMI devices may be operated as master on the MPI bus. Verify the
network settings of the connected devices.

Note

For comprehensive information relating to communication between the controller and the
HMI device, refer to the communication user manual.

Settings of the Runtime software

In the configuration software WinCC flexible, make the following settings for the Runtime
software:

e Display on the PLC

In WIinCC flexible, you configure the Runtime layout of the generated project: Select
whether to start the project in full-screen mode, or in a window smaller than the screen
size. In full-screen mode, the project is zoomed to the full screen. There will be no
window and operator control elements for this view.

Note

If the HMI screen does not match the configured size (in pixels), the project appears only
on a part of the screen when opened in full-screen mode.

To start the system in full-screen mode, open the "Device settings" dialog box in the
project view in WinCC flexible. Under "Runtime Settings", set the "Full-screen mode"
check box. You can hide the taskbar under Windows as required. To hide the taskbar,
select "Start > Settings > Taskbar", then clear the "Always on Top" and "Auto hide" check
boxes on the "Taskbar properties" dialog box.

e Dialog fonts

The dialog text will be shown in the standard font. You define the standard font in the
"Languages and fonts" editor.

e Disabling program switching

In order to prevent the operator from calling other applications in Runtime, you may lock
program switching. To do so, open the "Device settings" dialog box in the project view,
then set the "Disable program switching" and "Full-screen mode" check boxes. Also hide
the taskbar under Windows as described earlier.
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5.5 Test project

Note

If you decide to lock program switching, you should always configure a function key or
button for calling the "StopRuntime" system function. Otherwise, it will not be possible to
exit WinCC flexible Runtime or Windows.

When program switching is disabled, the <Ctrl+Alt+Del> keystroke function is also
disabled.

® Screen saver

A screensaver is no longer required for most modern screens and can even damage
them. These monitors switch to hibernate mode as soon as the video signal has not
changed for a specified time. A conventional screensaver would prevent this and thus
reduce the service life of your monitor.

Note

In case you do want to use a screensaver, please note that WinCC flexible Runtime is
only released for operation with the standard Windows screensavers.

e Setting the time zone

Make sure that the correct time zone is set on the PC on which the runtime software is
installed. To set the time zone in Windows, select Start > Settings > Control Panel >
Date/Time.

5.5 Test project

Function

WinCC flexible is supplied with a simulator software which you can use to test your project
offline. The simulator is a separate application. It allows you to debug the functions of
configured graphics, graphic objects, alarms etc.

The simulator simulates the control as follows:

e Defined modification of the values of configured tags, e.g. in increments or decrements,
sine-wave, random or by bit-shifting.

The simulation/runtime components must also be installed on your programming device in
order to run a simulation.
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5.5 Test project

Principle

You have various options of simulating your project:

Simulation with PLC connection

You can simulate you project directly in Runtime. In this case, tags and range pointers
will only function if your programming device is interconnected with a corresponding PLC.

By connecting your computer to the PLC, you can achieve an authentic simulation of your
configured HMI device during runtime. For simulation with WinCC flexible, select
"Compiler" > "Start Runtime" from the "Project” menu. Alternatively, click on the

3 symbol in the "Compiler" toolbar.

Simulation without PLC connection

The simulation program installed with WinCC flexible Runtime allows offline simulation of
your project, including its tags and flags. Specify the parameters of flags and tags in a
simulation table that will be read by the simulation program of WinCC flexible Runtime.

For simulation with the simulator, select "Compiler > Start Runtime with simulator" from

the "Project" menu. Alternatively, click on the ‘H,:',: symbol in the "Compiler" toolbar.

Simulation in integrated mode

An integrated configuration in STEP 7 allows you to simulate a PLC connection with
PLCSIM. For more information, please see the STEP 7 documentation.

Handling instructions

The following steps show the basic procedures for simulating a project offline without PLC
connection.

26

1.
2.

3.

Start by creating a project as it is going to be run later with an interconnected PLC.

Save and compile the project.

Launch the simulator directly from the running configuration software. Select "Compiler" >

start Runtime with simulator" from the "Project” menu. Alternatively, click on the

!.:u symbol in the "Compiler" toolbar.

When you simulate the project for the first time, the simulator is started with a new, empty
simulation table. If you have already created a simulation table for your project, it will be
opened.

The simulation table "*.sim" contains all your settings for the simulation of tags and flags.
You now manipulate the tags and flags of your project in the simulation table.

You can monitor the profile of the changing value by switching the task from simulation to
the project.

You can save all settings made in this table for project simulation to a file. To do so,
select "File > Save" in the Simulator, then type in a file name ("*.sim").

— You can now always retrieve these settings in order to simulate your project again.
The condition is here, that you have not reconfigured any of the tags or flags you want
to simulate in your project in the meantime.
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5.6 Transferring a project

Changing the language of the simulator user interface

The simulator neither provides a language change function, nor does it start using the
engineering language of WinCC flexible.

You change the user interface language of the simulator as follows:

1. Open the shortcut menu from "Start > SIMATIC > WinCC flexible 2008 >
WinCC flexible 2008 Runtime Simulator".

2. Click "Properties".

3. If you want to work on an English user interface, for example, replace the path definition
in the "Target" area with the following entry:

"C:\Program Files\Common Files\Siemens\HMiRTMSim\HMiRTmSim.exe" / 11033

Overview of language IDs required:

Language Language ID required
German 11031
English 11033
French 11036
Italian 11040
Spanish 11034
Chinese - Taiwan 11028
Chinese - China 12052
Japanese 11041
Korean 11042
5.6 Transferring a project

Overview
Various scenarios are possible for transferring the project:

® WinCC flexible Runtime is installed on the same PC as the WinCC flexible programming
software.

® WinCC flexible Runtime and the WinCC flexible programming software are installed on
different systems. In this case, the project must be downloaded from the programming
device to the destination device.

In the first step, you need to set the corresponding transfer properties in the "Loader
menu" on the HMI device.

Note

Depending on the configuration, the safety prompts request you to confirm overwriting of
online recipe data and user management data on the HMI device with offline
configuration data.
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5.6 Transferring a project

Rebuild all

Recompile the entire project by executing the "Rebuild all" command before releasing your
project to the production process.

It is also advisable to execute a "Rebuild all..." command at suitable intervals to reduce the
time required for compiling delta data in current engineering sessions.

Execute a full compilation by selecting the "Project > Compiler > Rebuild all..." menu
command.

The "Select HMI devices for generation" dialog opens after you have called the "Rebuild
all..." command and if you have configured several HMI devices.

Select the HMI devices to be generated from this dialog. Multiple selection is possible.

The programming software and runtime software are on the same system

If the configuration software and WinCC flexible Runtime are on the same system, proceed
as follows:

1. Create and then compile your project (e.g., named Myproject.hmi).

The compiled file with the file name extension *.fwx will be stored in the folder containing
the project file, e.g. "Myproject.fwx."

2. Start WinCC flexible Runtime directly from the running configuration software. Select
"Compiler" > start Runtime" from the "Project" menu. Alternatively, click on the
=3 symbol in the "Compiler" toolbar.

3. You may test and operate the project online with the controller if you have configured the
corresponding communication.

Configuration software and Runtime software on different systems
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If the programming software and WinCC flexible Runtime are installed on two different
systems, proceed as follows:

1. Create and then compile your project (e.g., named Myproject.hmi).

The compiled file with the file name extension *.fwx, e.g. Myproject.fwx, is stored in the
same folder.

2. To transfer the compiled file via cable:

Depending on the required type of transfer, use a suitable standard cable to interconnect
the HMI device with the programming device, then switch on the HMI device.

Note

If the HMI device is a PC, you can transfer the compiled file without using the loader, for
example, via Ethernet. To do so, double-click the compiled file on your PC to start
Runtime.

3. Download the compiled file from the programming device to your PLC.
Windows provides the following options of transferring the compiled file:

— Copy the file *.fwx to the PLC via the parallel or serial interface via dial-up connection
under Windows or copy the file *.fwx to the PLC via a network.

— Copy the *.fwx file to a diskette and then from the diskette to the destination PC.

WinCC flexible 2008 Runtime
User's Manual, 07/2008, 6AV6691-1BA01-3AB0



Setting up WinCC flexible Runtime
5.7 Runt the project

5.7 Runt the project

Introduction
You can start the project immediately after its transfer.

Project start modes
Options of starting a WinCC flexible project on a Runtime PC:
® Running it from the Explorer
You can run the project by double-clicking its file name in Windows Explorer.
e Starting together with Runtime

Enter the project file in "HMIRT.ini" in order to run it with the start of WinCC flexible
Runtime by means of the Windows Start menu.

® Run from the command line

To run your project, type in one command either at the MS-DOS prompt, or on the "Start
> Run" command line in Windows, and then press <Enter>. Note that the following
command line may diverge from its installation path:

c:\Programs\Siemens\SIMATIC WinCC flexible\WinCC flexible 2008
Runtimé\HmiRTm.exe c:\project\myproject.fwx

® Autostart

— If your project is linked to the Autostart directory of the Windows start menu, it will be
automatically upon system startup.

— ltis also possible to define the autostart settings in the "Settings" dialog box of the
WinCC flexible Runtime loader.

Note

Start the loader using the "SIMATIC\WinCC flexible 2008 Runtime >
WinCC flexible 2008 Runtime Loader" command in the Windows Start menu.

Missing objects in Runtime

If objects are not displayed in Runtime or startup of the project fails, rebuild the project by
selecting "Project » Generator » Rebuild all...". Transfer the project once again.
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5.8 Backup configuration data

5.8 Backup configuration data

Principle

Several years of operation in a rugged industrial environment may damage the hard disk
drive of your HMI device. To ensure that you can retrieve all programs and settings to the
new hard disk, create a backup copy of your hard disk configuration data. Refer to the
operating instructions of the HMI device for a detailed description of creating a backup.

Procedure

1. Run the backup program as directed in the description included with the SIMATIC HMI
device.

You have thus prepared the conditions for putting your HMI device into operation again
without any significant loss of time after you replace the hard disk drive.

A commonly available software can also be used to generate a backup copy.

5.9 Stop runtime

Introduction
You define the steps in closing Runtime in the user program:

Procedure
1. When Runtime is running in window mode, you can close it simply by clicking "Close".

2. When Runtime is running in full-screen mode, you can close it by means of the program
switching function and the Task Manager.

3. When Runtime is running in full-screen mode and program switching is disabled for the
project, the closing sequence of Runtime must be configured separately. Actuate the
relevant button to close Runtime.
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6.1 Screen objects in Runtime

Overview
WinCC flexible Runtime offers the following objects for operating and monitoring:
e Button
e Switch
e |O Field
® Graphic 1O Field
e Symbolic IO Field
® Alarm indicator
e Alarm view
® Alarm window
® Media Player "
® Recipe view
e Bar
® Trend View
e Slider
® Gauge
® Date-Time Field
® Clock
® User view
e Symbol Library
e Status Force
e HTML Browser
o Sm@rtClient View

Y for MP 377 only
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6.2 Alarms in Runtime
6.2 Alarms in Runtime
Alarms

Alarm classes

32

Alarms indicate events and states on the HMI device which have occurred in the system, in
the process or on the HMI device itself. A status is reported when it is received.

An alarm could trigger one of the following alarm events:

Activate
Deactivate

Acknowledge

The configuration engineer defines which alarms must be acknowledged by the user.

An alarm may contain the following information:

Date

Time

Alarm text
Location of fault
Status

Alarm class
Alarm number

Alarm group

Alarms are assigned to various alarm classes.

Warning

Warning alarms usually indicate states of a plant such as "Motor switched on". Alarms in
this class do not require acknowledgement.

Error

Alarms in this class must always be acknowledged. Alarms normally indicate critical
errors within the plant such as "Motor temperature too high".

System
System alarms indicate states or events which occur on the HMI device.

System alarms provide information on occurrences such as operator errors or
communication faults.

Diagnostic alarm

SIMATIC diagnostic alarms show states and events in the controllers SIMATIC S7 or
SIMOTION.

STEP 7 alarm classes
The alarm classes configured in STEP 7 are also available to the HMI device.
Custom alarm classes

The properties of this alarm class must be defined in the configuration.
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Alarm buffer

Alarm log

Alarm log

Alarm view

6.2 Alarms in Runtime

Alarm events are saved to an internal, volatile buffer. The size of this alarm buffer depends
on the HMI device type.

When alarm logging is enabled, alarm events are output directly to the printer.

You can set the logging function separately for each alarm. The system outputs "activated"
and "deactivated" alarm events to the printer.

The output of alarms of the "System" class to a printer must be initiated by means of the
corresponding alarm buffer. This outputs the content of the alarm buffer to the printer. To be
able to initiate this print function, you need to configure a corresponding control object in the
project.

Alarm events are stored in an alarm log, provided this log file is configured. The capacity of
the log file is limited by the storage medium and system limits.

The alarm view shows selected alarms or events from the alarm buffer or alarm log. Whether
alarm events have to be acknowledged or not is specified in your configuration. By means of
configuration, the display can be filtered in such a way that only alarms that contain a
specific character string will be shown.

The following HMI devices update the tag value in an alarm after the alarm status has
changed, for example by acknowledgment.

® OP 73micro

® TP 177micro

e OP73

e OP77A

e TP177A

The tag value at other HMI devices remains unchanged.

The following HMI devices do not resort active and unacknowledged alarms shown in an
alarm view after an alarm was acknowledged.

e OP 73micro
® TP 177micro
e OPT73

e OP77A

e TP177A
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6.3 Tags in Runtime

Alarm window

Alarm indicator

If configured, an alarm window shows all pending alarms or alarms awaiting
acknowledgement of a particular alarm class. The alarm window is displayed as soon as a
new alarm occurs.

You can configure the order in which the alarms are displayed. You can choose to display
the alarms in ascending or descending order of their occurrence. The alarm window can also
be set to indicate the exact location of the fault, including the date and time of the alarm
event. By means of configuration, the display can be filtered in such a way that only alarms
that contain a specific character string will be shown.

The alarm indicator is a graphic symbol that is displayed on the screen when an alarm of the
specified alarm class is activated.

The alarm indicator can have one of two states:
® Flashing: At least one unacknowledged alarm is pending.

e Static: The alarms are acknowledged but at least one of them is not yet deactivated. The
number indicates the number of queued alarms.

6.3 Tags in Runtime

Definition

Tags correspond to defined memory areas on the HMI device, to which values are written
and/or from which values are read. This action can be initiated by the PLC, or by the
operator at the HMI device.

6.4 Log files in Runtime

Overview

34

Alarm events and process values can be saved to log files.

Examples of alarm events are the incoming, acknowledged and outgoing events occurring
with an alarm message.

Process value logging is used for the following purposes, for example:
® FEarly detection of danger / fault states

® [ncrease of productivity

® Enhancement of product quality

e Optimization of maintenance cycles

® Documentation of processes

® Quality assurance
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Memory options

Alarm logs

6.4 Log files in Runtime

Depending on the configuration, the logs are written to a file or stored in a database set up
for this purpose.

® | ogging to a CSV file

The project engineer must have specified a folder path for storing the CSV file containing
your logged data. This references the storage location.

CSV format table columns are separated by separators, the table rows are terminated by
a line break character. This allows you to evaluate or edit your log data using an external
text editor or spreadsheet program, for example.

® | ogging to a database

By storing your log files in a database, you can utilize the full database functionality for
further processing and analysis of the logged data.

WinCC flexible supports logging via ODBC interface. This functionality was verified using
Microsoft SQL Server 2005 Express Edition.

Logging methods used in WinCC flexible Runtime:
e Circular log

® Segmented circular log

® | og with level-dependent system alarm

® | og file with data volume-based system alarm

Alarms in the project indicate fault states and operating states of a process. They are
generally triggered by the controller. Alarms can be output to the HMI in the form of images.
WinCC flexible lets you log alarms and document operational states and error states of the
plant.

The following data are logged to the file:

® Date and time of alarm

® Alarm number

® Alarm tags (up to 8)

e Alarm status

e Alarm text (optional)

® Fault location (optional)

All alarms are assigned to a specific alarm class. All alarm classes can be logged.
Alarms can be logged either automatically, or by operator intervention.

The contents of log files can be output to the HMI, if a corresponding alarm view has been
configured.
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6.5 Recipes in Runtime

Data logs

In Runtime, the process values are logged, processed and, depending on the project, written
either to files or to the log database.

Data logging is controlled by means of cyclic operations and events. Logging cycles are
used to ensure continuous acquisition and storage of the data. In addition, data logging can
also be triggered by events, e.g. when a value changes.

File storage on Windows 2003 Server

Only the HMI devices listed below support the storage of files such as logs and recipes on
Windows 2003 Server with Active Directory:

e MP 277

e MP 377

® Mobile Panel 277

® Mobile Panel 277 IWLAN

6.5 Recipes in Runtime
6.5.1 Recipes in Runtime
Overview

Recipes are a collection of associated data, e.g. machine configuration or production data.
This data can be generally transferred between the HMI device and PLC in a single step.
This way you can convert the production to a different product variant. If you have
programmed directly at the machine, for example, you can transfer the data to your HMI
device and write it to the recipe.

Operating recipes in Runtime

WinCC flexible offers two options of viewing and editing recipes and the corresponding
recipe data records in Runtime on the HMI device:

® Recipe view

® Recipe screen

WinCC flexible 2008 Runtime
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Recipe view

6.5 Recipes in Runtime

The recipe view is a screen object that is configured in the "Screens" editor.

The recipe view can be represented as follows:

® As enhanced recipe view

Recipe Mame: Mo,
|Orange j | 1

Data Record Name: Mo,
|Nectar j |2

Entry Mame YWalue 2
\Water 40
Concentrate (i

slax  aa

| Ready

® As simple recipe view

On HMI devices with displays smaller than 6" (e.g. OP 77B) the simple recipe view is
used to display and edit recipes.

1 Juice
2 Beverage
3 Nectar

.

For example, you can specify what operating function the recipe view will have in runtime:

The recipe view shows recipe data records in tabular form. The Recipe view is particularly
useful if data records are small in size or only a few values are to be modified.

In the recipe view, the recipe values are saved in the recipe data records. The recipe data
record is not transferred between the HMI device and PLC until you use the corresponding

operating element.
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6.5 Recipes in Runtime

Recipe screen

The recipe screen is a process picture. It contains an individual input screen for the recipes.
The input screen contains 10 fields and other screen objects. You have to implement the
recipe functionality with system functions, e.g. for saving recipe data records.

This makes it possible for you to input parameter data in the context of machine
visualization. The 1/O fields for a recipe can be distributed over multiple recipe screens, with
topical organization of recipe elements, for example.

No.
T 1
30 - Data record name No.:
30/ [ Nectar T 2
Save | Data from the PLC |
Load | Data to PLC |

In the recipe screen, the values are saved in recipe tags. Depending on the configuration,
the recipe values are transferred between the PLC and the HMI device either immediately or
after the respective operating element has been activated.

6.5.2 Structure of recipes

Introduction

38

The basic structure of a recipe is illustrated with reference to a filling station in a fruit juice
plant.

There may be several different recipes in an HMI device. A recipe can be compared to an
index card box that contains several index cards. The index card box contains several
variants for manufacturing a product family. The full data for each manufacturing variant is
contained on a single index card.

Example:

In a soft drinks production plant, a recipe is needed for different flavors. Drink variants
include fruit juice drink, juice and nectar.
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Recipe

FRecipe data record

Element

Recipe

Recipe data records
Each index card represents a recipe data record needed to manufacture a product variant.

Recipe entries

Each index card in a drawer is printed immediately. All the index cards contain fields for the
different ingredients. Each field corresponds to a recipe entry. All the records of a recipe thus
contain the same entries. The records differ, however, in the value of the individual entries.

Example:

All drinks contain the same components:
o Water

e Concentrate

® Sugar

® Flavoring

The records for juice drink, fruit juice or nectar differ, however, in the quantity of sugar used
in production.
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6.5.3

6.5.3.1

Recipe application

Transfer of recipe data records

Flow of data in recipes

—
/ synchronous \

.

HMI device m
Recipe view »w
<

Recipe 1

-

ecipe n

Recipe tag S
Recipe < >

1 ~_ 11/

external
memory medium

Interaction between the components
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There is interaction between the following components at runtime:

® Recipe view / recipe screen

On the HMI device, recipes are displayed and edited in the recipe view or in a recipe
screen.

— The recipe data records from the internal memory of the HMI device are displayed and
edited in the recipe view.

— The values of the recipe tags are displayed and edited in the recipe screen.

Depending on the configuration, the values displayed in the recipe view are synchronized
with the values of recipe tags.

HMI device recipe memory
Recipes are saved in the form of recipe data records in the HMI device's recipe memory.
Recipe tags

The recipe tags contain recipe data. When you edit recipes in a recipe screen, the recipe
values are stored in recipe tags. The point at which the values of the recipe tags are
exchanged with the PLC depends on the configuration.
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Note

You can synchronize the recipe tags with the recipe data records so that the same values
are saved in both.

Loading and saving recipe data

HMI device m
Recipe view >¥/
<

Recipe 1
Recipe 2

« Recipe 3
< > Recipe tag <>
Recipe

screen v

=0

Complete recipe data records are loaded from or saved to the recipe memory on the HMI
device in the recipe view.

The values of the recipe data record are loaded from the recipe memory to the recipe tags in
the recipe screen. When they are saved, the values of the recipe tags are saved to a recipe
data record in the recipe memory.

Transferring the recipe values between the HMI device and the PLC

HMI device m
Recipe view w

Recipe 1
Recipe 2

-
< o= Recipe 3
g > Recipe tag
Recipe

1 ~_ +

offline Yy

PLC

—

Complete recipe data records are transferred between the recipe view and PLC.
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The following transfers are possible between the recipe screen and PLC, depending on the
configuration:

® Transferring recipe data records between PLC and recipe tags

® |mmediate transfer of individual modified values between the PLC and recipe tags. The
following settings are needed in the recipe in order to do this:

"Synchronize tags" has been enabled.
"Tags offline" has been deactivated.

Recipe data records can be transferred directly between the HMI device and PLC. In these
situations, the display on the HMI device is not essential.

Exporting and importing recipe data records

HMI device m

Recipe 1
Recipe 2
Recipe 3

&//

External
storage medium

Recipe data records are exported from the HMI device recipe memory and are saved to a
CSYV file on the external storage medium. The records can be reimported from the storage
medium to the recipe memory.

The following external storage media may be used, depending on the HMI device:
e Memory card

e USB stick

e Hard disk
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6.5.3.2

Introduction

6.5 Recipes in Runtime

Configuration of recipes

Recipes are configured differently depending on the intended use.

e |f you are editing recipes with a recipe view in your project, the values are only saved in
recipe data records.

® |f you are editing recipes in a recipe screen in your project, the values are saved in recipe
tags.

The following possible settings determine how the recipe data records, recipe tags and PLC
all interact.

"Synchronize tags" deactivated

The data in a data record is only displayed and can only be edited in the recipe view. Using
these same tags outside of the recipe view does not affect their values.

"Synchronize tags" enabled

Differences may occur during runtime between the values displayed in the recipe view and
the values saved in the associated tags when you edit recipes with a recipe view and in a
recipe screen. To prevent this, the recipe data record values must be synchronized with the
values of the recipe tags.

HMI device m
Fevipe wview ‘\“““————"/
=5 O—1
//”/ synchroni ze
: . PRedpetag
Recipe J
SCHEEN
4 offline
PLC r

Note
Recipe tags can only be synchronized in the enhanced recipe view.
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The values of the recipe view and the associated recipe tags are not synchronized
automatically. The recipe tags and the recipe view are not synchronized until you use the
operating element with the "RecipeViewSynchronizeDataRecordWithTags" function.

"Synchronize tags" and "Tags offline enabled

With this setting, modified recipe values are not synchronized immediately between the
recipe tags in the recipe screen of the HMI device and PLC.

There must be an operating element with the "SetDataRecordToPLC" and
"GetDataRecordFromPLC" functions present in order to synchronize the values.

If recipe values are changed in the controller, the modified values are displayed immediately
in the recipe screen if you use the operating element with the "GetDataRecordFromPLC"
function.

"Synchronize tags" enabled and "Tags offline deactivated

With this setting, modified recipe values are synchronized immediately between the recipe
tags on the HMI device and PLC.

When you change recipe values in the recipe screen, these changes are applied
immediately by the PLC and immediately influence the process.

If recipe values are changed in the PLC, the changed values are displayed immediately in
the recipe screen.

6.5.3.3 Scenario: Entering recipe data records in Runtime

Obijective

Requirements

44

You want to enter production data on the HMI device without disturbing the process that is
currently underway. Therefore, the production data should not be transferred to the PLC.

® The recipe has been created. The recipe has the following settings:
"Synchronize tags" is checked or unchecked.
— If "Synchronize tags" is checked, then "Tags offline" must also be checked.

This will prevent the recipe tags being transferred automatically between the HMI
device and PLC.

® A recipe screen or mimic with recipe view is available.

® There is an operating element for saving the recipe data records.
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Sequence

6.5 Recipes in Runtime

Recipe view

/

Recipe

screen

HMI device

o="o

Synchronous

Recipe tag

Recipe Memory

Transfer the recipe data to the PLC

6.5.3.4

Obijective

WinCC flexible 2008 Runtime

User's Manual, 07/2008, 6AV6691-1BA01-3ABO

PLC

Scenario: Manual production sequence

/ Offline
o

2. Save the modified recipe data record.

. Enter the production data in the recipe view or recipe screen.

3. Alternatively save the recipe data record with a new name.

The recipe data record is saved in the recipe memory of the HMI device.

The configuration may provide operating elements for transferring recipe data to the PLC.

You want to be able to correct the transferred production data online, if necessary.

A reading device connected to the PLC reads a bar code on the work piece to be processed.
The recipe data record names correspond to the respective bar code names. This will enable
the PLC to load the necessary recipe data record from the storage medium of the HMI

device. The recipe data record is displayed for inspection on screen.
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Requirements
® The recipe has been created. The recipe has the following settings:
— "Synchronize tags" has been enabled.

— "Tags offline" has been deactivated.

Note
The changes are transferred immediately to the PLC

® There is a recipe screen available. There may also be an operating element for saving
the recipe data records in the recipe screen.

Sequence

HMI device W

Recipe o—o
screen Synchronous Recipe n
Recipe tag
Offline
PLC

Behavior when the recipe view is used

If the recipe view is used, it is not possible to transfer changes immediately. You must use
the operating element to transfer the recipe data record to the PLC.

6.5.3.5 Scenario: Automatic production sequence

Obijective

You want production to be executed automatically. The production data is to be transferred
directly to the PLC, either from the recipe memory in the HMI device or from an external
storage medium. The screen display is not necessary.
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Requirements
® The recipe has been created. The recipe has the following settings:
"Sychronization" is enabled under "Transfer".

The production data is transferred to the PLC, so it is necessary to synchronize with
the PLC to prevent the data from being accidentally overwritten.

Sequence

HMI device W

~_ ||~

PLC

s W
0 3 External storage
o medium

Implementation
You can control the flow of data in the following ways:

® The control program controls the automatic transfer via control jobs or, if necessary, via
WinCC flexible system functions.

The sequence is controlled via the status information in the mailbox and via return values
from the functions used.

® One or more scripts control the automatic transfer via WinCC flexible system functions.
The sequence can be checked using the values returned by the functions used.

You can implement the automatic production sequence with available system functions:

® "ImportDataRecords"

This function loads data records from a *.CSV file onto the recipe memory on the HMI
device.

o "SetDataRecordToPLC"

This function transfers a data record from the HMI device's recipe memory to the PLC.
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6.54 Displaying recipes

6.5.4.1 Recipe screen and recipe view

Recipe view

Recipe screen

You can display and edit recipes on the HMI device with a recipe view or recipe screen.

The recipe view is an off-the-shelf screen object in WinCC flexible.
The recipe view is available in the following views:

® As enhanced recipe view

® As simple recipe view

The operating elements of the enlarged recipe view and the possible operations in the
simple recipe view can both be set.

Note

It is advisable to use the simple recipe view on HMI devices with a display size of less than
6"

The recipe screen is a process picture. It contains an individual input screen for the recipes.
The input screen contains 10 fields and other screen objects. The recipe functionality is
implemented with system functions, e.g. for saving recipe data records.

Note
Recipe screen

You can configure a recipe screen in the TP 170B and higher models.

6.5.4.2 Recipe view

Recipe view

48

The recipe view is an off-the-shelf screen object used to manage recipe data records. The
recipe view shows recipe data records in tabular form.

The recipe view can be represented as follows:
® As enhanced recipe view
® As simple recipe view

The operating elements of the enlarged recipe view and the possible operations in the
simple recipe view can both be set.

The values displayed or entered in the recipe view are saved in recipe data records. The
recipe data records are exchanged with the PLC via system functions.
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Enhanced recipe view

The figure below shows an example of the enhanced recipe view.

Recipe Mame: Mo,
|Orange j | 1

Data Record Name: Mo,
|Nectar j |2

Entry Mame YWalue 2
WWlater 40
Concentrate 0™
B ||| x| i |
|Ready

Simple recipe view
The simple recipe view consists of three areas:
® Recipe list
e Data record list

® FElement list

In the simple recipe view, each area is shown separately on the HMI device. Depending on
the configuration, the simple recipe view starts with the recipe list.

The figure below shows an example of the data record list.

1 Juice

2 Beverage -+—
3 Nectar
—

Display of values

NOTICE

Changing the recipe data record in the background

Applies to the processing of a recipe data record:

If values of the corresponding recipe data record are changed by a control job, the recipe
view is not updated automatically.

To update the recipe view, reselect the respective recipe data record.
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6.5.4.3

Introduction

Principle

50

Recipe screen

The recipe screen is a process picture. It contains an individual input screen for the recipes.
The input screen contains 10 fields and other screen objects. The recipe functionality is
implemented with system functions, e.g. for saving recipe data records.

The figure below shows an example of the recipe screen.

_ 40 - Recipe name No.:
T ol g
[Sigar T 30 K@ Data record name No.:
AT o W [

Save | Data from the PLC |

Load | Data to PLC |

Note
You can configure a recipe screen in the TP 170B and higher models.

Configuration of a recipe screen offers you the opportunity for customization: You can
spread large recipes over several process screens according to topic and display them
vividly, using features such as graphical screen objects.

® Spreading recipes over several process screens according to topic

— You can distribute recipe data records with multiple entries across several process
images. E.g. for each plant section you can configure a process image containing the
associated input screens for the recipe data records.

Splitting recipes among several process screens is useful for HMI devices with small
displays. For one thing, you can avoid having to scroll in tables during runtime.

® isual machine simulation

You can visually simulate your machine in a process screen using graphical screen
objects. This enables you to display parameter settings more clearly by positioning 10
fields directly beside machine elements such as axes or guide rails. You can use this to
produce a direct reference between the values and the machine.
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Synchronize tags

You must enable the "Synchronize tags" function in the recipe properties in order to be able
to enter recipe data record values in the configured IO fields outside the recipe view. The
figure below shows the settings in WinCC flexible:

@ (x

B G I l >
enerdl Uptions
P Properties
B Data Medium Settings
% Options ¥ Synchronize tags
B Transfer
m Infotext [ Tags offline

You must synchronize the tags in order to synchronize data between the tags of the recipe
screen and the recipe data records displayed in the recipe view. Synchronization of tags is
only possible in the enhanced recipe view.

Tags offline

If the entered values are to be transferred immediately to the connected PLC during runtime,
you must disable "Tags offline" in the Properties window.

Configure the "SetRecipeTags" system function if you want to enable and disable immediate
transfer of entered values during runtime.

System functions
The following system functions are available for operator control of a recipe screen:
® |mportDataRecords
o ExportDataRecords
® | oadDataRecord
e SaveDataRecord
e SetDataRecordTagsToPLC
® GetDataRecordTagsFromPLC

WinCC flexible 2008 Runtime
User's Manual, 07/2008, 6AV6691-1BA01-3AB0 51



Runtime functionality

6.5 Recipes in Runtime

6.5.5

6.5.5.1

Introduction

52

The following system functions are available for operator control of the recipe view when it is
being used in the recipe screen:

® RecipeViewSaveDataRecord

® RecipeViewSaveAsDataRecord

® RecipeViewSynchronizeDataRecordWithTags
® RecipeViewDeleteDataRecord

® RecipeViewNewDataRecord

® RecipeViewGetDataRecordFromPLC

® RecipeViewRenameDataRecord (for simple recipe view only)
® RecipeViewShowOperatorNotes

® RecipeViewMenu (for simple recipe view only)
® RecipeViewOpen (for simple recipe view only)
® RecipeViewBack (for simple recipe view only)

The system functions for loading, saving, and transferring recipe data records and recipes
are located in the "Recipes" group.

Operating Recipes

Exporting and importing recipe data records

Based on your configuration, you can either export recipe data records to a CSV file for
editing in MS Excel, for example, or import these from a CSV file. The extent to which you
can influence these processes is determined by the project configuration.

Note

A list separator is used to separate the data records during importing and exporting. The list
separator used as the default depends on the setting for formats and numbers in the
operating system. Select "Start > Settings > Control Panel > Regional and Language
Options". If you want to import or export recipe data records, do not use this list separator in
the display name of the recipe data records.

The following fields can be configured on the user interface, for example, in order to use the
export/import function:

® Selection field for the recipe
® Selection field for the recipe data record
® Operating element with the "ExportDataRecords" functionality

e QOperating element with the "ImportDataRecords" functionality
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Export recipe data record
1. Select the relevant recipe and recipe data record from the selection boxes.

2. Use the operating element with the "ExportDataRecords" functionality.

Result
The recipe data record are exported to a CSV file.

Note
New data records created in runtime can be exported to an external file.

Importing recipe data records
1. Select the relevant recipe and recipe data record from the selection boxes.

2. Use the operating element with the "ImportDataRecords" functionality.

Result
The recipe data record are imported.

6.5.5.2 Using the recipe view
Recipe data record administration

Recipe data record administration
You can use the recipe view as follows, depending on the configuration:
® (Create new recipe data records
® Copy recipe data records
e Edit recipe data records

® Delete recipe data records

Creating new recipe data records

1. Select the recipe on the HMI device in which you want to create a new recipe data
record.

2. Click on the El button. Alternatively press the <Ctrl> + <Space> keys.

A new recipe data record with the next available number is created.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.
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3. Enter values for the elements of the data record.

The elements of the recipe data record can be assigned default values depending on the
configuration.

4. Click on the il button. Alternatively press the <Ctrl> + <*> keys.

The dialog "Save as" opens.
5. Enter a name for the data record.
6. Click on "OK" to confirm your input.
The data record is saved under the new name.

If the recipe data record already exists, a dialog is opened. In this dialog, specify whether
the existing data record is to be overwritten.

Result

The new recipe data records will be saved to the selected recipe. If the recipe data records
already exists, a system alarm will be output to the screen.

Copying a recipe data record
You copy a recipe data record by saving it under a new name.

1. Select the recipe on the HMI device in which you want to edit an existing recipe data
record.

2. Select the recipe data record that you want to copy on the HMI device.

3. Click on the il button in the recipe view. Alternatively press the <Ctrl> + <*> keys.

The dialog "Save as" opens.
4. Enter a name for the data record.

5. Click on "OK" to confirm your input.

Result
The recipe data record is stored under the new name.

Modify recipe data record

1. Select the recipe on the HMI device in which you want to edit an existing recipe data
record.

2. Select the recipe data record that you want to edit on the HMI device.

3. Replace the old values with new ones.

4. Click on the El button in the recipe view. Alternatively press the <Ctrl> + <Enter> keys.
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Result

6.5 Recipes in Runtime

The modified values are applied to the recipe data record.

Deleting a recipe data record

Result

1. Select the recipe on the HMI device in which you want to delete an existing recipe data

record.

2. Select the recipe data record that you want to delete on the HMI device.

3. Click on the il button in the recipe view. Alternatively press the <Ctrl> + <Del> keys.

The recipe data record is deleted from the data medium of the HMI device.

Synchronizing a recipe data record

Introduction

Requirements

WinCC flexible 2008 Runtime
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Differences between the following values may occur during runtime:
® The values displayed in the recipe view
® The actual values of the recipe tags

Depending on the configuration, the values displayed in the recipe view are synchronized
with the recipe tags. Synchronization always includes all the variables which belong to a

recipe data record.

NOTICE

Changed tag name

Tags and the value of the recipe data record cannot be assigned to each other if the tag
name of the tag to be synchronized has been changed. The tags in question are not
synchronized.

Note
Recipe tags can only be synchronized in the enhanced recipe view.

A recipe data record is displayed in the recipe view. The values of recipe tags were modified
by teaching, for example.
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Procedure

1. Click on the @ button in the recipe view. Alternatively press the <Ctrl> + <=> keys.

Result

The system always updates the current value of the recipe view with the up-to-date recipe
tag value.

When the value shown in the recipe view is more recent than the current recipe tag value,
the system writes this value to the recipe tag.

Read recipe data record from PLC

Introduction

The values which are also stored in the recipes in the HMI device can be changed directly in
the plant during runtime. This is the case, for example, if a valve was opened further directly
at the plant than is stored in the recipe. The values of the recipe data records saved in the
HMI device possibly no longer match the values in the PLC.

You can read the values of the recipe tags from the PLC and write them to a recipe data
record.

The read values are written to the recipe data record that is currently displayed on the HMI
device.

Procedure
1. Select the recipe on the HMI device.

2. On the HMI device, select the recipe data record of which you want to fetch the values
from the PLC.

it
3. Click on the ﬂl button in the recipe view. Alternatively press the <Ctrl> + <UP> keys.

Result
The values are read from the PLC and displayed on the HMI device.

Transfer recipe record to PLC

Introduction

For the values of a data record modified in the recipe view to take effect, you must transfer
the values to the PLC.

The display values in the recipe view are always transferred to the PLC.
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Procedure

1.
2.

3.

Result

6.5 Recipes in Runtime

Select the recipe on the HMI device.

On the HMI device, select the recipe data record of which you want to transfer the values
to PLC.

Click on the El button in the recipe view. Alternatively press the <Ctrl> + <Down> keys.

The values of the recipe data record are transferred to the PLC.

6.5.5.3 Using the simple recipe view

Recipe data record administration

Recipe data record administration

You can use the simple recipe view as follows, depending on the configuration:

Create new recipe data records
Copy recipe data records
Edit recipe data records

Delete recipe data records

Creating new recipe data records

1.

Select the recipe on the HMI device in which you want to create a new recipe data
record.

2. Open the recipe list menu.

3. Select the menu command "0 New".

A new data record with the next available number will be created.
The element list of the new recipe data record opens.
Enter values for the elements of the recipe data record.

The configuration data may already contain default values for the recipe data record.

. Open the element list menu.

— Select menu command "0 Save".
The "Save As" dialog opens.
— Under name, enter the name of the record. Click "OK" to save.
Alternatively you can return to the data record list. The "Save As" dialog opens.

— Under name, enter the name of the record. Click "OK" to save.
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Result

The new recipe data records will be saved to the selected recipe. If the recipe data records
already exists, a system alarm will be output to the screen.

Copying a recipe data record
You copy a recipe data record by saving it under a new name.

1. Select the recipe on the HMI device in which you want to copy an existing recipe data
record.

2. On the HMI device, select the recipe data record of which you want to save a copy.
3. Open the data record list menu.
4. Select menu command "2 Save As".

The "Save As" dialog opens. The recipe data record is automatically given the next free
recipe data record number.

5. Under name, enter the name of the record. Click "OK" to save.

Result
The recipe data record is stored under the new name.

Modify recipe data record

1. Select the recipe on the HMI device in which you want to edit an existing recipe data
record.

2. Select the recipe data record that you want to edit on the HMI device.
3. Open the desired data record.
The element list of the recipe data record is displayed.
4. Replace the old values with new ones.
5. Open the element list menu.

— Select menu command "0 Save".

Result
The modified values are applied to the recipe data record.

Delete recipe data record

1. Select the recipe on the HMI device from which you want to delete an existing recipe data
record.

2. Select the recipe data record that you want to delete on the HMI device.
3. Open the data record list menu.
4. Select the menu command "1 Delete".

A dialog opens.

5. Confirm this message to delete the data record.
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Result
The recipe data record is deleted from the data medium of the HMI device.

Read recipe data record from PLC

Introduction

The values which are also stored in the recipes in the HMI device can be changed directly in
the plant at runtime. This is the case, for example, if a valve was opened further directly at
the plant than is stored in the recipe. The values of the recipe data records saved in the HMI
device possibly no longer match the values in the PLC.

You can read the values of the recipe tags from the PLC and write them to a recipe data
record.

The read values are written to the recipe data record that is currently displayed on the HMI
device.

Procedure
1. Open the recipe on the HMI device.
The data record list opens.

2. Select the element list of the recipe data record to which you want to apply the values
from the PLC.

3. Open the element list menu.
4. Select the menu command "2 From PLC".
The values are read from the PLC and displayed in the current recipe data record.

5. If you want to save the values, select the menu command "0 Save" or "3 Save As".

Result

The values are read from the PLC, visualized on the HMI device and saved to the recipe
data record.

Transfer recipe record to PLC

Introduction

For the values of a data record modified in the recipe view to take effect, you must transfer
the values to the PLC.

The display values in the recipe view are always transferred to the PLC.
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Procedure

Result

6.5.5.4

Introduction

Effects

60

. Open the recipe you want to use.

The data record list opens.

Select the element list of the recipe data record whose values you want to transfer to the
PLC.

3. Open the element list menu.

4. Select the menu command "1 To PLC".

The values of the recipe data record are transferred to the PLC.

Reactions to modifications of the recipe structure

Different recipe structures can occur in the following situations:

In the event of changes during commissioning
When work is carried out on the machine by the machine manufacturer (retrofit)

When CSV files are imported, the structure of the CSV file can differ from the recipe
structure.

Nevertheless, you can still use any recipe data records already created.

CAUTION

When a tag is renamed, the assignment is lost.

Structural differences are handled as follows:

If the old recipe data record or the CSV file contains any additional values, these values
will be discarded.

If the old recipe data record or the CSV file contains values of the wrong data type, the
configured default value is used in the recipe data record.

Example: The recipe data record contains values that show the tank contents and were
input as floating point numbers. However, the corresponding recipe tag expects an
integer value. In this case, the system discards the transferred value and the configured
default value is used.

If the old recipe data record or the CSV file contains too few values, the configured
default value is again used in the recipe data record.
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6.6 Reports in Runtime

Overview

Output

Printing reports

Logs are used to document process data and completed production cycles. The log content
and layout are specified in the project, as is the event triggering the printout of the report.

For example, a log can be configured for output at the end of a shift, in order to record
downtimes. A log can also be configured for the purpose of the documentation of product
testing or quality inspections (ISO 9000).

Reports are printed in Runtime either automatically, e.g. by means of a scheduler, or
manually, e.g. by means of a softkey.

Reports are output to the printer in graphic mode. The use of a serial printer is not
recommended because of the accumulated data volume.

For proper output, the printer must support the paper format and page layout of the report.

Note

The value of a tag in the report is read and output at the moment of printing. A substantial
time may elapse between printing out the first and the last page of a report consisting of
several pages. This may lead to the same tag on the last page being output with a different
value from that on the first page.

6.7 System functions and scripts in Runtime

Application

System functions and scripts are used in Runtime for the following purposes:
® To control the process

® To use the properties of the HMI device

® To make system settings online on the HMI device

In WIinCC flexible, each system function and each script is linked to an object, such as a
button, field or screen, and an event. As soon as the event occurs, the system function is
triggered.

WinCC flexible 2008 Runtime
User's Manual, 07/2008, 6AV6691-1BA01-3AB0 61



Runtime functionality

6.7 System functions and scripts in Runtime

System functions

Scripts

Events

62

System functions are predefined functions that are used to implement many tasks in
Runtime, such as:

® calculations, e.g. increasing a tag value by a specific or variable amount
® | ogging function, e.g. starting a process value log
® Settings, e.g. changing the PLC or setting a bit in the PLC.

e Alarms, e.g. after a different user logs on.

Scripts may also be included in the project for specific applications which may require
additional functions. For the creation of scripts, WinCC flexible provides an interface to
Microsoft Visual Basic Script (VBScript). This allows you to integrate additional functions,
such as:

® conversion of values, e.g. between different physical units (temperatures)
e Automation of production sequences

A script can control a production sequence by transferring production data to a PLC. The
status can be checked based on the returned values, and appropriate measures can thus
be initiated.

The object and the selected function determine what events can be defined as triggers for
executing a system function.

For example, the events "Change Value", "Lower limit violated" and "Upper limit exceeded"
are associated with the "Tag" object. The "Loaded" and "Cleared" events are associated with
the "Screen" object.
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6.8 Security in Runtime

Overview

The configuration engineer can protect the operation of a project by implementing a security
system. The security system is based on authorizations, user groups and users.

The security system of the HMI device is based on authorizations, user groups and users.

If operator control objects protected by a password are operated, the operator has to logon
to the HMI device first. A login screen is displayed in which you enter your user name and
password. After logging on, you can operate the operator control objects for which you have
the necessary authorizations.

Log on g|

Llsets |

Password: |

04 Zancel

The login dialog can be set up by the configuration engineer via an individual operator
control object.

In the same way, the configuration engineer can set up an operator control object to log off.
After logging off, objects assigned password protection can no longer be operated; to do so,
log in again.

User groups and authorizations

Project-specific user groups are created by the configuration engineer. The "Administrators"
group is included in all projects by default. User groups are assigned authorizations. The
authorization required for an operation is specifically defined for each individual object and
function in the project.

Users
Each user is assigned to exactly one user group.
Users can be created as follows:
e By the configuration engineer during configuration
e By the administrator on the HMI device

® By a user with "Administration" authorization to the user administration on the HMI device
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6.8 Security in Runtime

Passwords

Only registered users may log on to Runtime by entering their user name and password. The
passwords can be assigned by the configuring engineer, by the "Admin" user (or by users
who have "Administration" authorization), or by the user himself.

The authorizations of a user after logging on depends on the user group to the user is
assigned.

After the project is transferred, only the administrator is authorized to create user accounts,
make user group assignments, and change passwords. Any other users who are
subsequently assigned to the "Administrator" group by the administrator may also carry out
these tasks.

The user data is encrypted and saved on the HMI device to protect it from loss due to power
failure.

Note

Depending on the transfer settings, changes to the user data are overwritten when the
project is transferred again.

Importing password lists

Logoff times

User view

64

The import of a password list which was exported from a ProTool Runtime is not supported.

A logoff time is specified in the system for each user. If the time between any two user

actions, e.g. entering a value or changing screens, exceeds this logoff time, the user is
automatically logged off. The user must then log in again to continue to operate objects
assigned password protection.

Note

If you enter the value "0" in the logoff time, there will be no automatic user logoff.

Use the User view to display the users on the HMI device.

Lser 1 ke Group (13 2
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6.9 Further operating options in Runtime

Export and import

The users, passwords, group assignments and logoff times established on the HMI device
can be exported and then imported on a different HMI device. This prevents you having to
enter all of the data again on another HMI device.

NOTICE

When importing, the currently valid user data is overwritten. The imported user data and
passwords are valid immediately.

6.9 Further operating options in Runtime

Print functions
Print functions available in online mode: :
® Hardcopy

You can print the content of the currently displayed screen if you utilize the "Print screen”
system function in your configuration.

® Printing alarms

Each alarm event that occurs (incoming, outgoing, acknowledgment) is also sent to a
printer.

® Printing reports

LED control

The light-emitting diodes (LED) in the function keys of the SIMATIC HMI devices can be
controlled from the PLC. For example, an illuminated or flashing LED can signal the operator
to press a specific function key on the device.

Language characteristics - Layout of the on-screen keyboard
The following applies to the layout of the on-screen keyboard:

The layout of the on-screen keyboard is not changed if the current Runtime language is not
installed on the PC.
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6.9 Further operating options in Runfime
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71 Basics for operation in Runtime
711 Introduction
Introduction

Operation of a process depends on how the project was created and the options available on
the HMI device. This chapter contains general information on the settings for the Runtime
software and the operation of predefined screen objects.

Screen objects provide general system functions. Screen objects may have been used and
configured in screens of the project.

WinCC flexible Runtime can be operated with the keyboard, mouse or touch screen,
depending on the HMI device used.

Note

The following HMI devices do not support mouse functions in Runtime:
e OP73

e OP 73micro

e OPT77A

e TP177A

e TP 177micro

Multiple key operation
If you are using a key device, you can press two function keys at once.

A\ caution

When you use a key device, you may not press more than two function keys
simultaneously.

If you use a touch device, standard PC or a panel PC, you may only press one function key
or button at a time.

In both cases, pressing too many keys may be inadvertently trigger actions.
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7.1 Basics for operation in Runtime

Change language

WinCC flexible allows you to configure a multilingual project. Up to five of these project
languages can be loaded simultaneously onto the HMI device.

You can switch between the individual languages in Runtime, provided this function has
been configured. When languages are switched, the language-dependent objects such as
texts or formats are displayed in another language. Objects that may contain language-
relevant texts include:

e Alarms

® Screens

® Text lists

® Operator notes
® Recipes

e Date/time

® Decimal symbol

e Static texts

Pictograms

HMI devices with integrated keyboard (e.g. Panel PC 670) may by configured with
pictograms on the bottom and on the left / right screen margins.

Pictograms are used to clarify the screen-specific functions of the function keys. Use the
associated function key to trigger the function symbolized by the pictogram.

Deleting characters

Activate numerical mode by pressing the <A-Z> keys to allow the deletion of characters
using the <Ins-Del> key. The <Ins-Del> key function is disabled if you activate the left or right
alphanumeric mode.

7.1.2 Operation with mouse and keyboard

Operation with the keyboard

The navigation options listed in the table can be used for keyboard operations in a screen.

Navigation PC SIMATIC Panel PC

Next field right/left <Shift+Right> / <Shift+Left> <Right> / <Left>

Next field up/down <Shift+Down> / <Shift+Up> <Down> / <Up>

To the right/left in the <Right> / <Left> <Shift+Right> / <Shift+Left>
field
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The other keys have identical functions on the PC and the SIMATIC Panel PC:

Key

Function

<Enter>

Applies a value (e.g. in unmarked input fields) or opens a
selection list.

If the 1/O field is marked (highlighted in color),

WinCC flexible Runtime will switch to the special editing
mode. Now, only one character will be marked in the field.

Use the cursor keys <Up>/<Down> to scroll through a
character table.

Use the cursor keys Right/Left to move the cursor to the
next or previous entry position.

Press <Enter> or <Esc> to exit from the entry mode. The
characters entered up to this point will be either applied or
discarded.

<Esc>

Interrupts the input.

<Tab>

Selects the next available screen object in the configured
tab sequence.

<Shift+Tab>

Selects the previously available screen object in the
configured tab sequence.

<F1>-... <F12>,
<Shift+F1>, ..., <Shift+F12>

On the PC: Triggers a function, e.g. screen selection.

<F1>, ...or<S1>, ...or <K1>, ...

On the SIMATIC Panel PC: triggers a global or local
function.

A caution

If you press a function key after a screen change, the associated function in the new screen
may be triggered before the new screen is fully displayed.

Controlling Windows with the keyboard

You may also use the keyboard to control the operating system of your HMI device. See
your Windows manual for detailed information. The most important key combinations for
SIMATIC Panel PCs are listed in the following table.

Navigation HMI device
Open start menu <Ctrl+Esc>
Show the shortcut menu of the selected element <Shift+F 10>
Select all <Ctrl+A>
Display properties of the selected element <Ctrl+Enter>
Explorer:

Change folder <F4>
Change display areas <F6>
Enable menu bar <F10>
Dialogs:
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Navigation HMI device

Go to next field <Tab>

Back to previous field <Shift+Tab>
Open next tab <Ctrl+Tab>
Open previous tab <Ctrl+Shift+Tab>

Operation with the mouse

A lightning symbol attached to the mouse pointer indicates that the screen object, for
example a switch, may be operated with the mouse.

Scresns [%f

Note

If a screen object is covered by another, e.g. a button from a rectangle with a transparent fill,
it is not possible to operate with the mouse in runtime.

The screen object can be operated with the keyboard.

Screens %

713 Operating the touch screen device

7.1.3.1 Operating touch objects

Operation

Touch objects represent touch-sensitive operator control objects on the HMI screen such as
buttons, 1/O fields and alarm windows. Touch objects are basically operated in the same way
as conventional keys. You operate touch objects by touching them with your finger.
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Use the "Release button on leave" option in the "Device settings" editor to determine the way
the system interprets the exit of the effective range of a button:

e Option enabled: The "Release" event is triggered in Runtime after the HMI has detected
that the operator is exiting the active range while keeping the button pressed. You must
exit the touch-screen user interface to re-enable the button for operation.

e Option disabled: The state of the button is still interpreted as being "Pressed" if the
operator exits the effective range while maintaining contact with the touch screen.

A\caution

The "Release button on leave" option has no effect on the operation of direct keys. The
state of the button is still interpreted as being "Pressed" if the operator exits the effective
range while maintaining contact with the touch screen.

A\cauTion

Never touch more than one object on the screen. Do not touch several touch objects
simultaneously. Otherwise, you can trigger an unintended action.

CAUTION

Do not use any pointed or sharp objects when operating the touch screen in order to
avoid damage to its plastic screen membrane.

Direct keys

With a PROFIBUS DP connection, it is also possible to configure buttons for operation as
direct keys in order to allow rapid operator inputs using keys. For example, jog mode
requires rapid operator inputs using keys.

PROFIBUS-DP direct keys place bits directly from the HMI device in the I/O area of a
SIMATIC S7.

Note

Direct keys can only be triggered by touch and not by a mouse click from a connected
external USB mouse.

Note

With touch operation, direct keys are triggered independent of any configured password
protection.

NOTICE

Direct keys are still active when the HMI device is in "offline" mode.
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Operation feedback

The HMI device responds with visual and auditory feedback as soon as it detects the
operation of a touch object. This feedback is independent of any communication with the
PLC. Therefore, this feedback does not indicate whether the relevant action is actually
executed or not.

Acoustic feedback

The HMI device outputs a beep to signal operation of a touch object. You can disable this
acoustic feedback.

Optical feedback

The type of optical feedback depends on the operator control object:

Buttons

The HMI outputs different views of the "Touched" and "Untouched" states, provided the
configuration engineer has configured a 3D effect:

—

Touched Untouched

The configuring engineer defines the appearance of a selected field (line width and color
for the focus).

Invisible buttons

The focus of hidden buttons is not marked after selection (focus width value is 0, default).
In Runtime, the outline of a touched button is indicated as a line when you modify the
value for the focus width in the configuration. This outline remains visible until the focus is
set on another operating object.

I/O fields

After you touch an /O field, a screen keyboard appears as feedback.

Operating screen objects with buttons

Screen objects with predefined buttons can also be operated with external buttons. To do so,
the corresponding system functions must have been linked to this button by the configuring
engineer.

In WIinCC flexible, these system functions are compiled in the "Keyboard actions for screen
objects" group.
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7.1.3.2 Input of values

Screen keyboard

The HMI device automatically opens the screen keyboard when you touch an input object
such as an 1/O field. This screen keyboard is also displayed to input of passwords for access
to protected functions. The keyboard is automatically hidden again when input is complete.

Based on the configuration of the input object, the HMI device shows a screen keyboard only
for the input of numeric or alphanumeric values.

The screen keyboard is activated by selecting an input object in runtime.

7.1.3.3 Entering alphanumeric values

Alphanumerical screen keyboard

Keyboard layers

Procedure

The HMI device automatically opens an alphanumeric on-screen keyboard for inputting
character strings and numeric values in hexadecimal format when you touch an input object
on the touch screen. The keyboard is automatically hidden again when input is complete.

The <Help> key is only active if an operator note has been programmed for the input object.
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Touch screen keyboard for alphanumeric input

The alphanumerical keyboard is organized in several layers:
e Standard layer (see the figure)

e <Shift> layer

e <Alt Gr> layer

e <Shift+Alt Gr> layer

The <Alt Gr> and <Shift+Alt Gr> layers are used for the input of special characters.

You enter alphanumeric values character-by-character using the on-screen keyboard
buttons. Confirm the input value with <Enter>, or cancel it with <Esc>. Both actions close the
screen keyboard.
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7.1.34

Entering numeric values

Numerical screen keyboard

Procedure

74

The HMI device automatically opens the numerical touch screen keyboard for entering
numerical values when you touch an 1/O field. The keyboard is automatically hidden again
when input is complete.

The <Help> button is only active if an operator note is configured for the 1/O field.

/189«
4|/5|6
1 2|3
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Screen keyboard for numeric input

You enter the characters of numeric values using the screen keyboard buttons. Confirm the
input value with <Enter>, or cancel it with <Esc>. Both actions close the screen keyboard.

Note

Limit values can be configured for numeric input fields. In this case, values are only accepted
if they lie within configured limits. If you enter a value that is outside the configured limits, the
system rejects this value and restores the original. The HMI outputs a system alarm to
indicate this situation.

When you enter the first character, a tooltip appears showing the hi and lo limit values of the
input field.
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7135 Calling the infotext

Purpose

The configuring engineer uses operator notes to provide additional information and operating
instructions with respect to alarms, screens, and operable screen objects. For example, an
operator note may contain information about the permissible range of values for an I/O field,
or information on the cause and remedy of a fault in the event of an error alarm.

T

Enter temperature setpaint for Tank_1
{Range 40...80 C)

Operator note for an I/O field (Example)

Help on messages

Press in the alarm window or in the alarm view.

Help on input objects

Touch the <Help> button on the on-screen keyboard. This button is only available if you
configured an operator note.

Help on the current screen

If, for example, the "ShowOperatorNotes" function is assigned to a button in your
configuration, you can call the configured operator note for the current screen by pressing
this button.

Help on the focused screen object

Use the <Alt+H> key combination on the screen keyboard or on the connected USB
keyboard to display the operator notes configured for the focused screen object.

Note
You cannot use any other screen object while the help window is open.

To view a new operator note, you first need to close the window showing the current
operator note.
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7.2 Operating graphic objects

Closing the help window
Click on the [Z4 button.

7.2 Operating graphic objects

7.2.1 Button

7211 Description

Application
A button is a virtual key on the screen of the HMI device that can have one or more
functions.
Text
Layout
The layout of the button depends on the button type.
e Button with text: The text shown on the button gives information regarding the status of
the button.
e Button with graphic: The graphic shown on the button gives information regarding the
status of the button.
® |nvisible: The button is not visible during Runtime.
Operation

Depending on the configuration, you can operate the button in the following ways:
e Standard operation: Click the button.

e Event: An event is triggered when you operate the button, e.g. when you click it. The
processing of a function list can be configured to the event.

Operation behavior

The operation may be followed with a optical feedback. However, note that the optical
feedback only indicates a completed operation and not whether the configured functions
were actually executed.
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7.2 Operating graphic objects
7.21.2 Mouse and keyboard control

Operation with the mouse
1. Click on the button with the mouse pointer.

Operation with the keyboard
1. Press the <Tab> key until the button is selected.

2. Press <Enter> or <Space Bar>.

Alternative operation
Depending on the configuration, you can also operate the button via the function keys.

Operation behavior
The behavior depends on the configuration.

Button with text, button with graphic

The operation may be followed with a optical feedback.

7.2.2 Switch
7.2.21 Description

Application

The switch is an operating element and display object with two states: "pressed" and
"released." Switches can signal the state of a system component that cannot be seen from
the HMI device, e.g. a motor. You can also change the state of that system component at the
HMI device.

Switch

T —
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Layout
The layout of the switch depends on the switch type.

e Switches: The switch has a slider. The position of this slider gives information about the
status of the switch.

® Switch with text: The text shown on the switch gives information regarding the status of
the switch.

e Switch with graphic: The graphic shown on the switch gives information regarding the
status of the switch.

Operation
Depending on the configuration, you can operate the switch in the following ways:
e Standard operation: Click the switch.

e Event: An event is triggered when you operate the switch, e.g. when you click it. The
processing of a function list can be configured to the event.

Operation behavior

A switch has two stable states: When you activate the switch, it changes to the other state.
The switch retains this state until the next operation.

7222 Mouse and keyboard control

Operation with the mouse
The behavior depends on the configuration.

Switch with slider
1. Click on the slider.

2. While holding down the mouse button, drag the slider to the other position.

Switch with text, switch with graphic
1. Click on the switch.

Operation with the keyboard
1. Press the <Tab> key until the switch is selected.

2. Press <Enter> or <Space Bar>.

Operation behavior
The behavior depends on the configuration.
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Switch with slider
The slider jumps to the other position.

Switch with text, switch with graphic
The switch changes the status.

7.2.3 1O field

7.2.31 Description

Application

You enter numeric or alphanumeric values in an 1/O field. For example, a numeric value
could be the number 80 as a temperature reference, an alphanumeric value could be the text
"Service" as a user name.

Layout
The layout of the I/O field depends on the configuration:
® Numeric I/O field
For input of numbers in decimal, hexadecimal or binary format.
® Alphanumeric 1/O field
For input of character strings.
® |/O field for date and time

For input of calendar dates or time information. The format depends on the set
configuration.

e |/O field for password entry

For concealed entry of a password. The entered character string is displayed with
placeholders (*).

Operation
Depending on the configuration, you can operate the 1/O field in the following ways:
e Standard operation: Enter a value in the I/O field.

e Event: An event is triggered after you operate the 1/O field, e.g. by activation. The
processing of a function list can be configured to the event.
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Operation behavior

Limit value test of numerical values

Tags can be assigned limit values. The entered value is then only accepted if the value lies
within the configured limits.

If an entered value exceeds a configured limit value, e.g. 80 with a limit value 78, the entered
value is rejected. If an alarm window is configured, then a system alarm is displayed
automatically. The original value is displayed again.

Decimal places for numerical values

If a numeric input field is configured with a specific number of decimal places, decimal places
in excess of the limit are ignored. Empty decimal places are filled with "0" after the number is
confirmed.

Hidden input

A "" is displayed for every character during hidden input. The data format of the value
entered cannot be recognized.

Behavior when switching between input fields

When you change to another input field within the same screen, and the screen keyboard
appears, the "Exit field" event is not executed for the previous field unless you close the
screen keyboard.

Behavior in the case of incorrect entries

I/O fields at the OP 73micro, TP 177micro, OP 73, OP 77A and TP 177A HMI devices
remain in editing mode when an incorrect entry is made. The original value is not restored
automatically, but only after the "ESC" key has been pressed.

Output fields closely spaced together

If you configure the 1/O fields as output fields with a transparent background, and if these
fields overlap so that the transparent part of one field covers the digits of the other field,
display problems can occur in runtime. To avoid such overlaps, set the margins of the 1/0
fields to zero in the object properties under "Properties > Layout" and activate the "Auto-
sizing" check box.

7.23.2 Operation with mouse and keyboard

Operation with the mouse
1. Click in the 1O field with the mouse pointer.
2. Type in the relevant value.

3. Confirm your input with <Enter> or cancel it with <Esc>.
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Operation with the keyboard
1. Press the <Tab> key until the IO field is selected.
2. Set the value.

3. Confirm your input with <Enter> or cancel it with <Esc>.

Alternative operation with the keyboard
1. Press the <Tab> key until the 10 field is selected.

2. Press <Return>. The object changes to the specific editing mode. Now, only one
character will be marked in the field.

3. Use the <Up>/<Down> cursor keys to scroll through a character table.

4. Use the <Right>/<Left> cursor keys to move the cursor to the next or previous input
position.

5. Confirm your input with <Enter> or cancel it with <Esc>.

724 Graphic /O field

7.241 Description

Application
A graphic IO field can have the following Runtime functions:
e Qutput of graphic list entries
® Combined entry and output
Example of its use as output field:

To indicate the Runtime status of a valve, the graphic IO field outputs the image of a closed
or open valve.

-
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Operation
Depending on the configuration, you can operate the graphic 10 field in the following ways:
e Standard operation: Select an entry from the graphic list.

e FEvent: An event is triggered when you operate the graphic IO field, e.g. when you
activate it. The processing of a function list can be configured to the event.

Operation behavior

If the graphic IO field displays a cactus image, you have not defined a graphic to be output
for a specific value in your project.

The contents of the graphic IO field change color to show that it is now activated.

The frame in 3D is only shown graphically in an output field.

7242 Mouse and keyboard control

Operation with the mouse
1. Click on the graphic 10 field. The selection list opens.

2. Click on the scroll bar with the mouse pointer. Move the scroll bar in the desired direction
while holding down the left mouse button.

3. Select the desired entry. The selection list is closed and the entry is displayed.

Operation with the keyboard
1. Press the <Tab> key until the graphic 1O field is selected.
2. Press <Enter>. The selection list opens.

3. Select the desired entry from the selection list. Toggle between the next or previous entry
by using the cursor keys <Left>, <Right>, <Up> and <Down>.

4. Confirm your input with <Enter> or cancel it with <Tab> or <Esc>.
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7.25 Symbolic 10 field

7.2.51 Description

Application
A symbolic 10 field can have the following Runtime functions:
® Qutput of text list entries
® Combined entry and output
Example of its use as combination 10 field:

To control a motor in Runtime, the operator selects the text "Motor OFF" or "Motor ON" from
the text list. The motor is then started or stopped in accordance with the selection. The
symbolic 1O field displays the respective status of the motor.

Operation
Depending on the configuration, you can operate the symbolic 10 field in the following ways:
e Standard operation: Select an entry from the text list.

® Event: An event is triggered when you operate the symbolic 10 field, e.g. when you
activate it. The processing of a function list can be configured to the event.

Behavior during operation

If the symbolic O field contains a blank text line in the selection list, no entries have been
defined in the project. The contents of the symbolic 10 field change color to show that it is
now activated.

7.25.2 Mouse and keyboard control

Operation using the mouse
1. Left mouse click on the symbolic 10 field. The selection list opens.

2. Click on the scroll bar with the mouse pointer. Move the scroll bar in the desired direction
while holding down the left mouse button.

3. Select the desired entry with the left mouse button. The selection list is closed and the
entry is displayed.
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Operation using the keyboard
1. Press the <Tab> key until the symbolic 10 field is selected.
2. Press <Enter>. The selection list opens.

3. Select the desired entry from the selection list. Toggle between the next or previous entry
by using the cursor keys <Left>, <Right>, <Up> and <Down>.

4. Confirm your input with <Enter> or cancel it with <Tab> or <Esc>.

7.2.6 Alarm indicator

7.2.6.1 Description

Application

During runtime, the alarm indicator is displayed if alarms of the specified alarm class are
pending or require acknowledgement.

/N

3

Layout
The alarm indicator can have one of two states:
® Flashing: At least one unacknowledged alarm is pending.

e Static: The alarms are acknowledged but at least one of them is not yet deactivated. The
number indicates the number of queued alarms.

Operation

The icons from the symbol library can only be operated with a mouse or touch screen.
Depending on the configuration, you can operate the alarm indicator in the following ways:

e Standard operation: Activate the alarm indicator.

® Event: The alarm window is shown or hidden by operating the alarm indicator, e.g. by
clicking. The processing of a function list can be configured to the event.

Operation behavior

Depending on the configuration, when operating the alarm indicator an alarm window is
opened.
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7.2.6.2 Mouse control

Operation with the mouse

1. Click on the alarm indicator with the mouse pointer. Depending on the configuration, the
alarm window is opened.

2. Use the Close icon to close the Alarm window and be able to operate the screens. The
alarm window can be opened again by clicking on the alarm indicator.

7.26.3 Alarm Indicator (OP 73, OP 73micro)

Application
There is a "simpler" alarm indicator available for the OP 73 and OP 73micro HMI devices.

The "simpler" alarm indicator is displayed if the alarms waiting to be acknowledged or
already acknowledged but still active alarms exist.

A

Layout
The alarm indicator can have one of two states:
® Flashing: At least one unacknowledged alarm is pending.

e Static: The alarms are acknowledged but at least one of them is not yet deactivated.

Operation

The alarm indicator is used only for visualization and cannot be operated. Alarms can be
acknowledged with the button <ACK>, for example.

Operation behavior

Displaying dialogs

The displayed alarm indicator is covered by system dialogs, e.g. login dialog, Help dialog
and alarm text windows. When this is closed, the alarm indicator is again visible.
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7.2.7 Alarm view

7271 Description

Application

Alarms are indicated in the alarm view or in the alarm window on the HMI device. The layout
and operation of the alarm window correspond to that of the alarm view.

The alarm window is independent of the process screen. Depending on the configuration,
the alarm window appears automatically as soon as a new, unacknowledged alarm has been
received. The alarm window can be configured so that it only closes after all the alarms have
been acknowledged.

Mo, Time Cate

by

Layout

Depending on the configuration, in the alarm view different columns with information
regarding an alarm or an alarm event are displayed. Establishes that only alarms that
contain a specific character string will be displayed in the alarm text.

To differentiate between the different alarm classes, the first column in the alarm view
contains a symbol:

Symbol Alarm class

! Error

(empty) Warning

(depends on the configuration) | Custom alarm classes

$ System

S7 Diagnostic alarm

Note

The layout of the alarm window in Runtime depends on the device settings of the target
device.

Operation
Depending on the configuration you can:
® Change the column sequence
® Change the order in which the alarms are displayed
e Acknowledge alarms

e Editing alarms
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Operator controls
The buttons have the following functions:

Button Function
= Displays an alarm operator note
& Editing alarms
E Acknowledge alarm

Operation behavior

Linked alarm window for touch panels
When configuring the alarm window for a keyboard unit, select "Properties > Mode", then set
the "linked" (modal) window property. This ensures that the alarm window does not defocus
during screen changes. This is important, as the switching between the screen and different
windows with <Ctrl+TAB> is not supported. If the linked alarm window has the focus, then
the buttons in the screen behind it cannot be operated. The functions configured on a

function key are carried out.

Changing the order of the displayed alarms

When you click on the column, first of all alarms requiring acknowledgement are sorted
according to date and time. Then those alarms that do not require acknowledgement are

sorted according to date and time.

7272 Mouse and keyboard control

Introduction
Within an alarm view there is a tabulator sequence that enables the operating elements and

the last selected alarm to be selected via the keys of the HMI device.

Operation with the mouse
1. Click on the alarm to be edited.

2. Click on the operating element you wish to use.
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Operation with the keyboard
1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. You can use the keys <Home>,<End>,<Up> and <Down>
for this

3. Press the <Tab> key until the operating element you wish to use is selected.

4. Press <Enter>.

Alternative operation
Depending on the configuration, you can also operate the alarm view via the function keys.

Example: Change the sequence of the columns
1. Choose the column header e.g. the "Date" column header.

2. While holding down the mouse button, drag the column header to the column header
"Time".

Example: Change the order of the columns
1. Click on the column header.

2. Click the same column header again to reverse the sort order.

Example: Acknowledge alarm
1. Click on the alarm to be edited.

2. Click on the £ button.

Example: Edit alarm
1. Click on the alarm to be edited.

2. Click on the L button.

Operation behavior

When you edit an unacknowledged alarm, it is acknowledged automatically.
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7.2.8 Simple alarm view

7.2.81 Description

Application

The simple alarm view shows selected alarms or alarm events from the alarm buffer or alarm
log. The layout and operation of the simple alarm window correspond to that of the simple
alarm view.

Note
The "Single alarm view" object cannot be operated dynamically with a script.

In the Engineering System you can dynamically control, for example, the visibility of an
object in the "Animations" group in the Properties window. In Runtime, the "Simple alarm
view" does not support animations. If you have configured an animation, and, for example,
wish to perform a consistency check of the project, then an error message is issued in the
output window.
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Layout Depending on the configuration, in the alarm view different columns with information
regarding an alarm or an alarm event are displayed.
To differentiate between the different alarm classes, the first column in the alarm view
contains a symbol:
Symbol Alarm class
! Error
(empty) Warning
(depends on the configuration) | Custom alarm classes
$ System
Operation
Depending on the configuration you can:
® Acknowledge alarms
e Editing alarms
Operator controls

The buttons have the following functions:

Button Function

J Acknowledge alarm

Edit alarm

=

Displays an alarm operator note

b

Shows the full text of the selected alarm in a separate window, the alarm text window.

Ad

In the alarm text window, you can view alarm text that requires more space than is
available in the alarm view. Close the alarm text window with

<1

Scrolls one alarm up

L3

Scrolls one page up in the alarm view

[

Scrolls one page down in the alarm view

s

Scrolls one alarm down

El
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Layout of the operator controls

On the operating panels OP 73micro and TP 177micro the simple alarm view has a button
that displays the message text in a separate window. This button is not displayed during the
configuration of the simple alarm view in the Engineering System.

The layout of the buttons for using the simple alarm view depends on the configured size.
You should therefore check on the operating panel whether all the required buttons are
available.

7.2.8.2 Mouse and keyboard control

Introduction

Within the simple alarm view there is a tabulator sequence that enables the operating
elements and the last selected alarm to be selected via the keys of the HMI device.

Operation with the mouse
1. Click on the alarm to be edited.

2. Click on the operating element you wish to use.

Operation with the keyboard
1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. You can use the keys <Home>,<End>,<Up> and <Down>
for this

3. Press the <Tab> key until the operating element you wish to use is selected.

4. Press <Enter>.

Alternative operation
Depending on the configuration, you can also operate the alarm view via the function keys.

Example: Acknowledge alarm
1. Click on the alarm to be edited.

2. Click on the J button.

Example: Edit alarm
1. Click on the alarm to be edited.

2. Click on the ﬂ button.
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Example: Calling the infotext
1. Click on the alarm to be edited.

2. Click on the j command button.

3. To close the window for displaying the operator note, press the E button or use the key
combination <Alt+F4>.

7.2.9 Recipe view
7.2.91 Description

Application

The recipe view is used to display, edit and manage data records.

Recipe Mame: Mo,
|Orange j | 1
Data Record Name: Mo,

|Nectar I j |2

Entry Mame YWalue 2

WWlater 40

Concentrate 0™

SETE

| Ready

Operation
Depending on the configuration you can:
® Create, change, copy or delete recipe data records
® Synchronize recipe data records with the associated recipe tags
® Read recipe data records from or transfer to the PLC
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The following operating elements can be configured in the recipe view:

Button

Hotkeys

Function

7

The configured help text is displayed.

L

<Ctrl+Space Bar>

Creates a new recipe data record.
If a start value is configured, it is shown in the input field.

<Ctrl+Enter>

Saves the displayed values of the recipe data record.
The storage location is predefined by the project.

=
=

<Ctrl+*>

The recipe data record is saved under a different name regardless
of the recipe view. A dialog box opens in which the name is
entered.

<Ctrl+Del>

The displayed recipe data record is deleted.

<Ctrl+=>

The system always updates the current value of the recipe view
with the up-to-date recipe tag value.

When the value shown in the recipe view is more recent than the
current recipe tag value, the system writes this value to the recipe
tag.

"Synchronize tags" must be enabled in the recipe properties
before this function can be used.

<Ctrl+Down>

The values of the set recipe data record displayed in the recipe
view are transferred to the PLC.

<Ctrl+Up>

The recipe values from the PLC are displayed in the recipe view.

Mouse control or touchscreen control of the recipe view

1. Select the recipe you want to use.

The records for the recipe are displayed.

2. Click on the data record you wish to edit.

3. Press the button whose function you wish to execute.

Using the keyboard with the recipe view
1. Press the <Tab> key until the recipe is selected in the recipe view.

2. Press <Enter>.

The drop-down list box for the recipes opens.

3. Choose a recipe or a record from the list. Toggle between the next or previous entry by
using the cursor keys <Left>, <Right>, <Up> and <Down>.

4. Press the <Tab> key until the operating element you wish to use is selected.
Alternatively, you can operate the recipe view via key combinations.
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7.2.10 Simple recipe view

7.2.10.1  Description

Display mode
The simple recipe view consists of three areas:
® Recipe list
e Data record list
® Element list
1 Juice
2 Beverage Ei
& Nectar
—
Simple recipe view - example with data record list
In the simple recipe view, each area is shown separately on the HMI device. You can use
the shortcut menu to operate each of these display areas.
The simple recipe view always begins with the recipe list.
Operation

You can use the simple recipe view as follows, depending on the configuration:
® Create, change, copy or delete recipe data records
® Read recipe data records from the PLC or transfer to the PLC

Using the simple recipe view

Toggle between the display areas and the shortcut menus to operate the simple recipe
views.

The table below shows the operation of the display area.

Button Key Function
<Enter> The next lowest display area is opened, i.e. the data
record list or the element list.
+ <Esc> The previous display area opens.
- <Right> The shortcut menu of the display area opens.
<Up>/<Down> Selects the previous/next entry.
<Pg Up>/<Pg Moves the display up or down one page.
Down>
<Home>/<End> Selects the first/last entry. The first/last entry is
selected.

WinCC flexible 2008 Runtime
94 User's Manual, 07/2008, 6AV6691-1BA01-3AB0



Operating a project in Runtime

7.2 Operating graphic objects

The table below shows the operation of the shortcut menu:

Button Key Function

ﬂ <Esc> The menu is closed.
The display area opens.

Input of the number | The menu command is executed.
of the menu
command

Shortcut menus of the simple recipe view

A command option selection can be called in for each display area by pressing the :l
button. The command selection lists those commands that are available in the current
display area. A number is assigned to each command. The command is executed when you
enter this number.

® Recipe list

Menu command Function
New A new recipe data record is created for the selected recipe.

If a start value is configured, it is shown in the input field.
Viewing info text The info text configured for the simple recipe view is displayed.
Open The record list of the selected recipe opens.

e Data record list

Menu command Function

New Creates a new recipe data record.
If a start value is configured, it is shown in the input field.

Delete The displayed record is deleted.

Save as The selected data record is saved under a different name. A dialog box
opens in which the name is entered.

Rename The selected record is renamed. A dialog box opens where you can enter
the name.

Open The element list of the selected data record opens.

Previous The recipe list opens.

® FElement list

Menu command Function

Save The selected record is renamed.

ToPLC The display values of the selected record are transferred from the HMI
device to the PLC.

From PLC The recipe values from the PLC are displayed on the HMI device in the
recipe view.

Save as The data record is saved under a new name. A dialog box opens where you
can enter the name.
Press the <ESC> key to open the data record list.

The following menu commands can also be configured on the TP 177A and OP 77A HMI
devices:
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Data record list

Menu command Function

To PLC The displayed values of the selected data record are transferred from the
HMI device to the PLC.

From PLC The recipe values from the PLC are displayed in the recipe view of the HMI
device.

Display help ... Displays the help text configured for the simple recipe view.

® Element list

Menu command Function

Display help ... Displays the help text configured for the simple recipe view.

Rename Renames the selected data record. A dialog box opens where you can
enter the name.

Previous Opens the data record list.

Mouse control or touchscreen control of the simple recipe view

1.

2.

Select the desired recipe from the recipe view.

Click on the Zl button.

The shortcut menu is opened.

Select the desired menu command.

The menu command is executed.

Alternatively, open the desired recipe in the recipe view.

The data record list is displayed.

. Open the desired data record. Alternatively use the :l button to open the shortcut menu

and select a menu command.

The menu command is executed.

Using the keyboard with the simple recipe view

96

1.
2.
3.

Press the <Tab> key until the simple recipe view is selected.
Select the desired recipe with the cursor keys.

Press <Right>.

The shortcut menu is opened.

Press the <Down> key until the desired menu command is selected.

5. Press <Enter> to confirm the command.

6. Alternatively, press the number of the desired menu command.

The menu command is executed.
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7.211 Trend view

7.2.11.1  Description

Application

The trend view is a dynamic display object. The Trend view can display actual process data
and process data from a log continuously when it is supported by the HMI device.

1007 100
80 /v 50

401 H40

20

201
0

10:05:32 AM 10:07:52 AM
2252005 2252005

Trend  Tagconnection  “alue Date/Time h
G_oo1 | T_too | 21 | 25.02.2005 10:0¢ v
4 b

Layout

The layout of the trend view is based on the configuration. A trend view can show multiple
curves simultaneously to allow the user, for example, to compare different process
sequences. If the displayed process value exceeds or falls below the configured limit values,
the violation of the limit can be displayed by a change of color in the curve.

A ruler can also simplify the reading of the process values from the trend view. The ruler
displays the Y-value that belongs to an X-value.

Operation
Depending on the configuration you can:
® The displayed time section extends.
® The displayed time section reduces.
e Scroll back by one display width.
e Scroll forwards by one display width.

e Stop or continue the trend recording.
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Control elements

The buttons have the following functions:

Control element

Function

Scrolls back to the beginning of the trend recording. The start values of the trend
recording are displayed there.

Zooms the displayed time section

Zooms out of the displayed time section

Moves the ruler backward (to the left).

Moves the ruler forward (to the right).

Scrolls one display width backward (to the left).

Scrolls one display width forward (to the right).

Shows or hides the ruler. The ruler displays the X-value associated with a Y-value.

IR

Stops or continues trend recording

7.2.11.2 Mouse and keyboard control

Operation with the mouse

1. Click on the desired button with the mouse button.

Operation with the keyboard

1. Press the <Tab> key until the trend view is selected.

2. Press the desired key combination.
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The table below shows the shortcut keys used to control the trend view:

Key Key (Panel PC) Function

<Ctrl+Enter> <Ctrl+Enter> Scrolls back to the beginning of the trend recording. The
start values of the trend recording are displayed there.

<Ctrl+Plus> <Ctrl+Plus> Zooms the displayed time section

<Ctrl+Minus> <Ctrl+Minus> Zooms out of the displayed time section

-- <Ctrl+Alt+Left> Moves the ruler backward (to the left).

-- <Ctrl+Alt+Right> Moves the ruler forward (to the right).

<Shift+Left> <Left> Scrolls one display width backward (to the left).

<Shift+Right> <Right> Scrolls one display width forward (to the right).

Alternative operation

Depending on the configuration, you can also operate the button via the function keys.

Slider control

Description

The slider is used to transfer a numerical value to the PLC by moving the slide to the desired
position. Each change in the position of a slider element causes the corresponding value in
the associated tag to change immediately.

WinCC flexible 2008 Runtime
User's Manual, 07/2008, 6AV6691-1BA01-3AB0

99



Operating a project in Runtime

7.2 Operating graphic objects

Layout

If the slider control is used as a display object, the value represented is determined by the
position and configuration of the movable slider.

Operation

Depending on the configuration, you can operate the slider control in the following ways:

e Standard operation: Activate the slider.

e Event: An event is triggered when you operate the slider, e.g. when you activate it. The
processing of a function list can be configured to the event.

Operation behavior

Note

The displayed value on the slider control may deviate from the actual value in the following

circumstances:

e The value range (minimum and maximum value) configured for the slider control does not
correspond to the configured limits for the slider control tag.

¢ Aninvalid password has been entered for a password-protected slider control.

7.212.2 Mouse and keyboard control

Operation with the mouse

1. Click the slider control.

2. Move the slider control in the desired direction while holding down the mouse button.

Operation with the keyboard

1. Press the <Tab> key until the trend view is selected.

2. You can operate the slider with the following keys:

Key

Key (Panel PC)

Function

<Up> or <Right>

<Shift+Up> or <Shift+Right>

Increase value

<Down> or <Left>

<Shift+Down> or <Shift+Left>

Reduce value

<Page up>

Increase value in 5% increments

<Page down>

Reduce value in 5% increments

<Home>

Set maximum value

<End>

Set minimum value

100
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7.213 Date/time field

7.2.13.1  Description

Application
A "Date / time box" may have the following runtime functions:
e Qutput of the date and time
® Combined input and output; here the operator can edit the output values so as to reset
the date and time.
5/14/2007 5:34, 27 PM
Layout
The layout in the date/time field depends on the language set in the HMI device.
The date can be displayed in detail (e.g. Tuesday, 31 December 2003) or in short form
(31.12.2003).
Entries in 24-hour format are always interpreted correctly on OP 73micro, TP 177micro,
OP 73, OP 77A and TP 177A HMI devices, irrespective of the date/time field format.
Operation

Depending on the configuration, you can operate the date/time field in the following ways:

e Standard operation: Change date and time.

Operation behavior

When the operator ignores the syntax when entering values, or enters illegal values, the
system rejects these. Instead, the original values (plus the time that has elapsed in the
meantime) will appear in the date/time field and a system alarm will be displayed on the HMI
device.

Conversion behavior
If invalid data are entered for the date and time, the conversion result can contain errors.

For example, month values greater than 12 can be entered. In this case the month data
could be swapped with the day data in WinCC flexible when the date is imported.

® Example:
11/13/2007 is imported as 13/11/2007.
Check the values entered for DATE and DATE_AND_TIME carefully.
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7.2.13.2 Mouse and keyboard control

Operation with the mouse
1. Click in the date/time field.
2. Type in the relevant value.
3. Confirm your input on the HMI with <Return> or cancel it with <Esc>.

Operation with the keyboard
1. Press the <Tab> key until the date/time field is selected.
2. Set the value.

3. Confirm your input with <Enter> or cancel it with <Esc>.

Alternative operation with the keyboard
1. Press the <Tab> key until the date/time field is selected.

2. Press <Enter>. The object changes to the specific editing mode. Now, only one character
will be marked in the field.

3. Use the <Up>/<Down> cursor keys to scroll through a character table.

4. Use the <Right>/<Left> cursor keys to move the cursor to the next or previous input
position.

5. Confirm your input with <Enter> or cancel it with <Esc>.

7.214 User view

7.2.14.1  Description

Application

The user view is used by the administrator to manage user accounts, group assignments
and user passwords.

Users can change their passwords and logoff times.

Lsger 1 Ak Group {1} 5
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Layout

Operation

7.2 Operating graphic objects

The user view contains four columns for the user, password, group and log-off time. The
passwords are encrypted by means of asterisks.

e All users on the HMI device system are displayed in the User view to the administrator or
to a user with administrator authorizations.

® \When user administration authorization is lacking, only the personal user entry is
displayed.

Depending on the configuration you can:
® Manage users, e.g. create, delete.
® (Change existing user data.

e Export or import user data.

Note

On an HMI device the number is restricted to 100 users and one PLC user. This
restriction does not apply to PCs. On a PC, the maximum number of users is restricted by
the physical memory.

Operation behavior

If a user with administrator rights is registered in runtime, in the user view on the HMI
devices OP 73, OP 77A and TP 177A the user "PLC user" is shown also.

Note

Changes to the settings of the user logoff time in Runtime are only effective after this user
was logged off.

Change existing user data

The following options are available for the range of changes that can be made:

® The administrator or a user with user administration authorization can change the data for
all users on the HMI device system in the user view.

— User name
— Group assignment
— Password
— Logoff times
® A user without user administration authorization can only change their own user data:

Password

Logoff time
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Note
If you enter the value "0" in the logoff time, there will be no automatic user logoff.

Note

An additional dialog will be displayed when you alter a password. The input of the password
is concealed.

Export or import user data
A user view contains all users, passwords, group assignments and logoff times set up on the
HMI device. To eliminate the necessity of reentering all data again on another HMI device,
you can export the user view, and then import it to another device. However, this is only
possible if this function has been configured.

Note

Do not export the password list immediately after changing it. Exit the "User view" object
after making changes and wait until the changes have been written to the internal Flash

memory before performing the export.

NOTICE

The currently valid passwords are overwritten during an import. The imported user data and
passwords are valid immediately.

7.214.2 Mouse and keyboard control

Operation with the mouse
1. Click in the user view.
2. Click on the user to be edited.
3. Edit the user data.

Operation with the keyboard
1. Press the <Tab> key until the user view is selected.

2. Click on the user to be edited. You can use the keys <Home>,<End>,<Up> and <Down>
for this

3. Edit the user data
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Example: Create user

1. Click on an empty line in the "User" column of the user view.
2. Then enter the user name. Press <Enter>.

3. Use <Right> to select the next field.
4

. Assign a password and a logoff time in the same way and then select the group.

Example: Changing group assignments

7.2.15

7.2.15.1

Application

Layout

1. Click in the "Group" field.

2. Select a group from the selection list. Alternatively, you can use the cursor keys
<Home>,<End>,<Up> and <Down> for this

3. Confirm the entry with <Enter>.

Simple user view

Description

On HMI devices with a small display, the simple user view is used to display users on the
HMI device.

Cperator Gruppe (2
PLC User Gruppe (1)
Note

The "Simple user view" object cannot be operated dynamically with a script.

The layout depends on the user rights.

e All users on the HMI device system are displayed in the User view to the administrator or
to a user with administrator authorizations.

® \When user administration authorization is lacking, only the personal user entry is
displayed.
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Operation

Depending on the configuration you can:

Operation behavior

Manage users, e.g. create, delete.
Change existing user data.

Export or import user data.

Note

On an HMI device the number is restricted to 100 users and one PLC user. This
restriction does not apply to PCs. On a PC, the maximum number of users is restricted by
the physical memory.

If a user with administrator rights is registered in Runtime, in the user view on the HMI
devices OP 73, OP 77A and TP 177A the user "PLC user" is shown also.

Note

Changes to the settings of the user logoff time in Runtime are only effective after this user
was logged off.

7.2.15.2 Mouse and keyboard control

Operation with the mouse

1.
2.

Click on the user name to be edited.

Change the user data. Custom user data (name, password, group, logoff time) is entered
sequentially in several dialogs.

use the "OK" button to confirm the entries.

Operation with the keyboard

1.
2.
3.

106

Press the <Tab> key until the simple user view is selected.
Click on the user to be edited.

Confirm the selection by pressing the <Enter> key. You can change the user data in the
following dialogs.

use the "OK" button to confirm the entries.
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The following table shows the available key operations for entering custom user data in the

dialogs:
Key Function
<Up>/<Down>: Selects the previous/next user
<Tab> Selects the next element in the dialog
<Enter> Opens the next dialog
<DEL> Deletes the selected user.

Example: Changing user data
1. Click on the user name to be edited. The following dialog opens:

? E3

—_

Lizer: ||_,|5|3r

Password: m
(B4 Caticel

2. If necessary, change the user name and password. Click on the "OK" button. The
following dialog opens:

Sroup:

Logoff timne; |5

(04 Cancel |

3. If necessary, change the user group and the logoff time. Click on the "OK" button.
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7.2.16 Status force

7.2.16.1  Description

Application
You read or write access values of the connected PLC directly in the Status force view. The
Status force view allows you to carry out operations such as monitoring or modifying the
addresses of the PLC program, without the need of an online connection via PC or PG.
el KA
Note
The Status force view can only be used in combination with SIMATIC S5 or SIMATIC S7.
Layout

The screen shows the general layout of the status / control screen object. Every row

represents an address.

The table shows the meaning of the individual columns.

Column

Function

Connection

The PLC of which the address ranges are to be displayed

Type, DB number, offset, bit

The address range of the operand

Data type, format

The data type of the operand

Status value

The value that was read from the given address of the operand

Control value

The value to be written to the given address of the operand
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Depending on the configuration you can:

Control elements

Change the column sequence.

To reverse the "Format" and "Control value" columns, drag the "Format" header to the
"Control value" header while holding down the mouse button.

Write the control value in the PLC.

The buttons have the following functions:

Button

Function

_ 6|

Updates the display in the status value column.

The button engages when it is pressed. You cannot operate any input fields
until the button is actuated again and the refresh is stopped.

_a |

Accepts the new value in the control value column. The control value is then

written to the PLC.

7.216.2 Mouse and keyboard control

Operation with the mouse
1. Click on the respective field.
2. Enter the value using the keyboard, or select a value from the selection list.

3. Click the desired buttons to write or read the values.

Operation with the keyboard
1. Press the <Tab> key until the Status force view is selected.
2. Press the desired key combination.
The following table shows the key combinations for operating the Status force view.

Key Key (Panel PC) Function

<Ctrl+Enter> <Ctrl+Enter> Operating the "Write" button
<Ctrl+Space Bar> <Ctrl+Space> Operating the "Read" button
<Ctrl+Left> <Ctrl+Shift+Left> Selects first field in current row
<Ctrl+Right> <Ctrl+Shift+Right> Selects last field in current row
<Ctrl+Up> <Ctrl+Shift+Up> Selects first field in current column
<Ctrl+Down> <Ctrl+Shift+Down> Selects last field in current column
<Ctrl+Del> <Ctrl+INS/DEL> Deletes current row

<Enter> <Enter> Opens selection list
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7.217 HTML browser

7.217.1 Description

Application

You can use the HTML Browser to browse web sites. This allows you to access additional
information.

Note

A change of HTML Browser functionality to support file explorer functions by entering a
folder or drive , for example \ or c:, or by connecting to an FTP sever (ftp://... for example) is
not released in WinCC flexible. One reason this function is not implemented is to prevent
inadvertent changes to files, their deletion or execution.

To prevent unintentional activation of this mode, your program should only accept valid
HTML pages entered, for example, using symbolic selection fields. The program may contain
an entry with password protection for service purposes.

Operation

The HTML Browser is used to display Web pages. You click a relevant link to open a further
page.

Control elements
The "HTML Browser" object does not feature any internal control elements.

Operation behavior
The HTML Browser is responds in the same way as the Internet Explorer.

The project engineer can also provide for the input of an Internet address by means of an 1/0
field. You open a page in the HTML Browser by entering the corresponding address.
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Remarks
The functional scope of the HTML Browser is limited in comparison to the Internet Explorer:

® The HTML Browser will only show pure HTML pages. VBScript, Java, JavaScript and
ActiveX controls are not supported. Set up the HTML pages for display in the HTML
Browser by using a text editor or using a simple HTML editor.

® Links to embedded files, for example *.pdf or *.xls, are not supported.

® (Queries and dialogs that are conducted during the access of corresponding pages are
not supported. This means that, for example, access to pages with invalid certificates is
possible. In order to access pages which require authentication the user name and the
password can be specified in the URL: <http://User_Name:Password@Server_Name>
(for example, http://otto:asdf@192.168.56.199).

7.217.2 Mouse and keyboard control

Operation with the mouse
1. Click in the address line.
2. Enter the Internet address.

3. In order to reach a linked page, click on the link.

Operation with the keyboard
1. Press the <Tab> key until the address line is activated.

2. Enter the Internet address. The HTML browser opens the page in question.
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7.2.18 Sm@rtClient view

7.2.18.1  Description

Application

The Sm@rtClient view may be used to start remote monitoring and control of another HMI
device. With an appropriate configuration, the Sm@rtClient view can be used to monitor and
control a system process from multiple HMI devices with the same authorizations.

Layout

The Sm@rtClient view displays the current Runtime screen of the remote device on your
HMI device.

You can now monitor and control this screens according to your configuration. Scroll bars
are displayed if the screen of the remote HMI device is larger than that of the current HMI
device.

Operation

Depending on the configuration, you can operate the Sm@rtClient view in the following
ways:

o Keys

In operation mode, all keys have the same function as those on the remote HMI device.
You can therefore use the <Tab> key to move from one object to another on the remote
screen, in the order of the tab configuration.

® Function keys

When you press a function key that has been configured with a function, this function will
be executed in your project.

If you press a function key that has not been configured with a function in your project, it
will actuate the respective function key on the remote HMI device.
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Monitoring mode
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Note

In the event of emergency, you can override the operation block on the remotely
controlled or currently inactive HMI device by clicking on the user interface five times in
succession or pressing the <Shift> key five times in succession. Then you may have to
enter a specific (configured) password.

On a Sm@rtClient view which is configured for monitoring mode, you can only monitor the
remote HMI device. You cannot control its operation.

In this case, the keys retain their standard functions. Press <Tab> to open the next object in
the current screen of your project.

Behavior during operation

If the program cannot resolve the dynamic address of a Sm@rtClient display, after a screen
change the system connects to the configured server using the static address of the server.
If a tag is now set using the dynamic address, you can make a second connection to this
server. As a remedy you should preset the tags of the dynamic address e.g. via a script.

7.2.18.2 Sm@rtClient view - mouse and keyboard control

Operation with the mouse

1.
2.

Click on the desired control object with the mouse pointer.

Click on the scroll bar with the mouse pointer. Move the scroll bar in the desired direction
while holding down the left mouse button.

Press the left mouse button for a few seconds on an empty area. The shortcut menu is
opened.

Select the desired menu command.

Operation with the keyboard

1.

Press the <Tab> key until the Sm@rtClient view is selected.

2. Move the scroll bar in the desired direction using <Ctrl+Up> and <Ctrl+Down>.
3.
4. Select the desired menu command with <Alt+Shortcut key>.

Open a menu line with the key combination <Shift+Ctrl>.
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Operation behavior

Call

Stop

114

The call for starting remote monitoring or control can be configured in different ways. You
can open the view of the runtime of the remote operator device with the following steps,
depending on the project:

Automatically when the device is started (and selection of the screen with the
Sm@rtClient view, if this is not the start screen)

By activating the Sm@rtClient view with the <Tab> key or (on a touch screen device)
through a touch

By entering the IP address of the remote HMI device and, if required, entering a
password in the appropriate field in the Sm@rtClient view

Note

If you enter an incorrect password five time in succession, all attempts to establish a
connection are rejected for the next ten seconds.

The screen showing the display of the remote HMI device can be configured to be closed in
different ways. Depending on the configuration, you can terminate the remote monitoring or
remote operation and open the next object of your own project by taking one of the following
steps:

Press the appropriate key.
Click "Exit".
Exit the screen.

Press <Shift+Ctrl> or (with touch devices) press a clear spot for an extended period. The
menu opens with the corresponding menu item.
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7.2.19 Symbol library

7.2.19.1  Description

Application

The symbol library is a comprehensive library with images from the areas of technology and
production.

Operation
Depending on the configuration, you have the following methods of operation:

e Event: An event is triggered when you operate the symbol, e.g. when you activate it. The
processing of a function list can be configured to the event.

Operation behavior

The active mouse function is signaled in Runtime by a changing cursor icon according to
your configuration.

There is no operator feedback, for example with color changes.

7.2.19.2 Mouse control

Operation with the mouse
1. Click on the symbol with the mouse pointer.

2. The functions are event-triggered.
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Appendix

8.1 System alarms

Introduction
System alarms on the HMI device provide information about internal states of the HMI device
and PLC.
The following overview shows the causes of system alarms and how to eliminate the cause
of error.

Some of the system alarms described in this section are relevant to individual HMI devices
based on their range of features.

Note

System alarms are only indicated if an alarm window was configured. System alarms are
output in the language currently set on your HMI device.

System alarm parameters

System alarms may contain encrypted parameters which are relevant to troubleshooting
because they provide a reference to the source code of the runtime software. These
parameters are output after the text "Error code:"

Meaning of the system alarms

All the system alarms that can be displayed are listed below. The system alarms are divided
into different ranges:

Table 8-1 10000 - Printer alarms

Number Effect/cause Remedy

10000 The print job could not be started or was canceled | Check the printer settings, cable connections and the
due to an unknown error. Faulty printer setup. Or: power supply.
No authorization is available for accessing the Set up the printer once again. Obtain a network printer
network printer. authorization.
Power supply failure during data transfer. If the error persists, contact the Hotline!

10001 No printer is installed or a default printer has not Install a printer and/or select it as the default printer.
been set up.

10002 Overflow of the graphics buffer for printing. Up to Allow sufficient intervals between successive print jobs.
two images are buffered.
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Number Effect/cause Remedy

10003 Images can now be buffered again. --

10004 Overflow of the buffer for printing lines in text mode | Allow sufficient intervals between successive print jobs.
(e.g. alarms). Up to 1000 lines are buffered.

10005 Text lines can now be buffered again. --

10006 The Windows printing system reports an error. Repeat the action if necessary.

Refer to the output text and the error ID to
determine the possible causes. Nothing is printed
or the print is faulty.

Table 8-2 20000 - Global script alarms

Number Effect/causes Remedy

20010 An error has occurred in the specified script line. Select the specified script line in the configuration.
Execution of the script was therefore aborted. Note | Ensure that the tags used are of the allowed types.
the system alarm that may have occurred prior to Check system functions for the correct number and
this. types of parameters.

20011 An error has occurred in a script that was called by | In the configuration, select the script that has been
the specified script. called directly or indirectly by the specified script.
Execution of the script was therefore aborted in the | Ensure that the tags used are of the allowed types.
called script. Check system functions for the correct number and
Note the system alarm that may have occurred types of parameters.
prior to this.

20012 The configuration data is inconsistent. The script Recompile the configuration.
could therefore not be generated.

20013 The scripting component of WinCC flexible Reinstall WinCC flexible Runtime on your PC.
Runtime is not correctly installed. Therefore, no Rebuild your project with "Project > Generator >
scripts can be executed. Generate" and transfer the project to the HMI device.

20014 The system function returns a value that is not Select the specified script in the configuration.
written in any return tag. Check whether the script name has been assigned a

value.

20015 Too many successive scripts have been triggered | Find what is triggering the scripts. Extend the times,
in short intervals. When more than 20 scripts are e.g. the polling time of the tags which trigger the
queued for processing, any subsequent scripts are | scripts.
rejected. In this case, the script indicated in the
alarm is not executed.

Table 8-3 30000 - Alarms for IFwSetValue: SetValue()

Number Effect/causes Remedy

30010 The tag could not accept the function result, e.g. Check the tag type of the system function parameter.
when it has exceeded the value range.

30011 A system function could not be executed because | Check the parameter value and tag type of the invalid
the function was assigned an invalid value or type | parameter. If a tag is used as a parameter, check its
in the parameter. value.

30012 A system function could not be executed because | Check the parameter value and tag type of the invalid

the function was assigned an invalid value or type
in the parameter.

parameter. If a tag is used as a parameter, check its
value.
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Table 8-4 40000 - Linear scaling alarms

Number Effect/causes Remedy

40010 The system function could not be executed since Check the parameter types in the configuration.
the parameters could not be converted to a
common tag type.

40011 The system function could not be executed since Check the parameter types in the configuration.
the parameters could not be converted to a
common tag type.

Table 8-5 50000 - Data server alarms

Number Effect/causes Remedy

50000 The HMI device is receiving data faster than it is --
capable of processing. Therefore, no further data is
accepted until all current data have been
processed. Data exchange then resumes.

50001 Data exchange has been resumed. -

Table 8-6 60000 - Win32 function alarms

Number Effect/causes Remedy

60000 This alarm is generated by the --
“DisplaySystemAlarms” function. The text to be
displayed is transferred to the function as a
parameter.

60010 The file could not be copied in the direction defined | Restart the system function or check the paths of the
because one of the two files is currently open or the | source/target files. Using Windows NT/XP: The user
source/target path is not available. executing WinCC flexible Runtime must be granted
It is possible that the Windows user has no access | access rights for the files.
rights to one of the two files.

60011 An attempt was made to copy a file to itself. Check the path of the source/target file.

It is possible that the Windows user has no access | Using Windows NT/XP with NTFS: The user executing
rights to one of the two files. WinCC flexible Runtime must be granted access rights
for the files.
Table 8-7 70000 - Win32 function alarms
Number Effect/causes Remedy
70010 The application could not be started because it Check whether the application exists in the specified

could not be found in the path specified or there is
insufficient memory space.

path or close other applications.
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Number Effect/causes Remedy
70011 The system time could not be modified. Check the time which is to be set.
The error alarm only appears in connection with Using Windows NT/XP: The user executing WinCC
area pointer "Date/time PLC". Possible causes: flexible Runtime must be granted the right to change
e Aninvalid time was transferred in the job the system time of the operating system.
mailbox.
e The Windows user has no right to modify the
system time.

If the first parameter in the system alarm is
displayed with the value 13, the second parameter
indicates the byte containing the incorrect value.

70012 An error occurred when executing the function Close all programs currently running.
"StopRuntime" with the option "Runtime and Then close Windows.

operating system".

Windows and WinCC flexible Runtime are not
closed.

One possible cause is that other programs cannot
be closed.

70013 The system time could not be modified because an | Check the time which is to be set.
invalid value was entered. Incorrect separators may
have been used.

70014 The system time could not be modified. Possible Check the time which is to be set.
causes: Using Windows NT/XP: The user executing WinCC
e An invalid time was transferred. flexible Runtime must be granted the right to change

e The Windows user has no right to modify the the system time of the operating system.

system time.
Windows rejects the setting request.

70015 The system time could not be read because --
Windows rejects the reading function.

70016 An attempt was made to select a screen by means | Check the screen number in the function or job with the
of a system function or job. This is not possible screen numbers configured.
because the screen number specified does not Assign the number to a screen if necessary.
exist. Check the details for the screen call and whether the
Or: A screen could not be generated due to screen is blocked for specific users.

insufficient system memory.
Or: The screen is blocked.
Or: Screen call has not been executed correctly.

70017 Date/time is not read from the area pointer because | Change the address or set up the address in the PLC.
the address set in the PLC is either not available or
has not been set up.

70018 Acknowledgment that the password list has been --
successfully imported.

70019 Acknowledgment that the password list has been --
successfully exported.

70020 Acknowledgment for activation of alarm reporting. | --

70021 Acknowledgment for deactivation of alarm --
reporting.

70022 Acknowledgment to starting the Import Password --
List action.

70023 Acknowledgment to starting the Export Password --
List action.
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Number

Effect/causes

Remedy

70024

The value range of the tag has been exceeded in
the system function.

The calculation of the system function is not
performed.

Check the desired calculation and correct it if
necessary.

70025

The value range of the tag has been exceeded in
the system function.

The calculation of the system function is not
performed.

Check the desired calculation and correct it if
necessary.

70026

No other screens are stored in the internal screen
memory.
No other screens can be selected.

70027

The backup of the RAM file system has been
started.

70028

The files from the RAM have been copied in the
Flash memory.

The files from the RAM have been copied in the
Flash memory. Following a restart, these saved
files are copied back to the RAM file system.

70029

Backup of the RAM file system has failed.
No backup copy of the RAM file system has been
made.

Check the settings in the "Control Panel > OP" dialog
and save the RAM file system using the "Save Files"
button in the "Persistent Storage" tab.

70030

The parameters configured for the system function
are faulty.

The connection to the new PLC was not
established.

Compare the parameters configured for the system
function with the parameters configured for the PLCs
and correct them as necessary.

70031

The PLC configured in the system function is not
an S7 PLC.

The connection to the new PLC was not
established.

Compare the S7 PLC name parameter configured for
the system function with the parameters configured for
the PLC and correct them as necessary.

70032

The object configured with this number in the tab
order is not available in the selected screen.

The screen changes but the focus is set to the first
object.

Check the number of the tab order and correct it if
necessary.

70033

An e-mail cannot be sent because a TCP/IP
connection to the SMTP server no longer exists.
This system alarm is generated only at the first
attempt. All subsequent unsuccessful attempts to
send an e-mail will no longer generate a system
alarm. The event is regenerated when an e-mail
has been successfully sent in the meantime.

The central e-mail component in WinCC flexible
Runtime attempts, in regular intervals (1 minute), to
establish the connection to the SMTP server and to
send the remaining e-mails.

Check the network connection to the SMTP server and
re-establish it if necessary.

70034

Following a disruption, the TCP/IP connection to
the SMTP server could be re-established.
The queued e-mails are then sent.
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Number Effect/causes Remedy
70036 No SMTP server for sending e-mails is configured. | Configure an SMTP server:
An attempt to connect to an SMTP server has In WinCC flexible Engineering System
failed and it is not possible to send e-mails. using "Device settings > Device settings"
WinCC flexible Runtime generates the system . .
) . In the Windows CE operating system
alarm after the first attempt to send an e-mail. - . .
using "Control Panel > Internet Settings > E-mail >
SMTP Server"

70037 An e-mail cannot be sent for unknown reasons. Check the e-mail parameters (recipient etc.).
The contents of the e-mail are lost.

70038 The SMTP server has rejected sending or Check the domain of the recipient address or disable
forwarding an e-mail because the domain of the the authentication on the SMTP server if possible.
recipient is unknown to the server or because the SMTP authentication is currently not used in WinCC
SMTP server requires authentication. flexible Runtime.

The contents of the e-mail are lost.

70039 The syntax of the e-mail address is incorrect or Check the e-mail address of the recipient.
contains illegal characters.

The contents of the e-mail are discarded.

70040 The syntax of the e-mail address is incorrect or --
contains illegal characters.

70041 The import of the user management was aborted Check your user management or transfer it again to
due to an error. the panel.

Nothing was imported.

70042 The value range for the tags has been exceeded Check the desired calculation and correct it if
while executing the system function. necessary.
The system function calculation has not been
carried out.

70043 The value range for the tags has been exceeded Check the desired calculation and correct it if
while executing the system function. necessary.
The system function calculation has not been
carried out.

Table 8-8 80000 - Archive alarms

Number Effect/causes Remedy

80001 The log specified is filled to the size defined (in Store the file or table by executing a ‘move’ or ‘copy’
percent) and must be stored elsewhere. function.

80002 A line is missing in the specified log. -

80003 The copying process for logging was not --
successful.

In this case, it is advisable to check any
subsequent system alarms, too.

80006 Since logging is not possible, this causes a In the case of databases, check whether the
permanent loss of the functionality. corresponding data source exists and start up the

system again.

80009 A copying action has been completed successfully. | --

80010 Since the storage location was incorrectly entered | Configure the storage location for the respective log
in WIinCC flexible, this causes a permanent loss of | again and restart the system when the full functionality
the functionality. is required.
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80012 Log entries are stored in a buffer. If the values are | Archive fewer values.
read to the buffer faster than they can be physically | Or:
written (using a hard disk, for example), Increase the logging cycle.
overloading may occur and recording is then
stopped.

80013 The overload status no longer applies. Archiving --
resumes the recording of all values.

80014 The same action was triggered twice in quick --
succession. Since the process is already in
operation, the action is only carried out once.

80015 This system alarm is used to report DOS or --
database errors to the user.

80016 The logs are separated by the system function Reconnect the logs.

"CloseAllLogs" and the incoming entries exceed
the defined buffer size.
All entries in the buffer are deleted.

80017 The number of incoming events cause a buffer Stop the copy action.
overflow. This can be caused, for example, by
several copying actions being activated at the
same time.

All copy jobs are deleted.

80019 The connection between WinCC flexible and all --
logs were closed, for example, after executing the
system function "CloseAllLogs".

Entries are written to the buffer and are then written
to the logs when a connection is re-established.
There is no connection to the storage location and
the storage medium may be replaced, for example.

80020 The maximum number of simultaneously copy Wait until the current copying actions have been
operations has been exceeded. Copying is not completed, then restart the last copy action.
executed.

80021 An attempt was made to delete a log which is still Wait until the current copying actions have been
busy with a copy action. Deletion has not been completed, then restart the last action.
executed.

80022 An attempt was made to use the system function In the project, check
"StartSequencelog” to start a sequence log fora | o if the "StartSequenceLog" system function was
log which is not configured as a sequence log. No properly configured.
sequence log file is created. o if the tag parameters are properly provided with

data on the HMI device.

80023 An attempt was made to copy a log to itself. In the project, check
The log is not copied. e ifthe "CopyLog" system function was properly

configured.
o if the tag parameters are properly provided with
data on the HMI device.

80024 The "CopyLog" system function does not allow Edit the "CopyLog" system function in the project if
copying when the target log already contains data | necessary. Before you initiate the system function,
("Mode" parameter). The log is not copied. delete the destination log file.

80025 You have canceled the copy operation. -

Data written up to this point are retained. The
destination log file (if configured) is not deleted.
The cancellation is reported by an error entry
$RT_ERRS at the end of the destination log.
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80026 This alarm is output after all logs are initialized. --
Values are written to the logs from then on. Prior to
this, no entries are written to the logs, irrespective
whether WinCC flexible Runtime is active or not.

80027 The internal Flash memory has been specified as Configure "Storage Card" or a network path as the
the storage location for a log. This is not storage location.
permissible.

No values are written to this log and the log file is
not created.

80028 The alarm returns a status report indicating that the | --
logs are currently being initialized. No values are
logged until the alarm 80026 is output.

80029 The number of logs specified in the alarm could not | Evaluate the additional system alarms related to this
be initialized. The logs are initialized. alarm. Check the configuration, the ODBC (Open
The faulty log files are not available for logging Database Connectivity) and the specified drive.
jobs.

80030 The structure of the existing log file does not match | Delete the existing log data manually, in advance.
the expected structure.

Logging is stopped for this log.

80031 The log in CSV format is corrupted. Delete the faulty file.
The log cannot be used.

80032 Logs can be assigned events. These are triggered | Close WinCC flexible Runtime, delete the log, then
as soon as the log is full. If WinCC flexible Runtime | restart WinCC flexible Runtime.
is started and the log is already full, the event is not | Or:
triggered. Configure a button which contains the same actions as
The log specified no longer logs data because itis | the event and press it.
full.

80033 "System Defined" is set in the data log file as the Reinstall SQL Sever 2005 Express.
data source name. This causes an error. No data is
written to the database logs, whereas the logging to
the CSV logs works.

80034 An error has occurred in the initialization of the No action is necessary. However, it is recommended to
logs. An attempt has been made to create the save the backup files or delete them in order to make
tables as a backup. This action was successful. A | the space available again.
backup has been made of the tables of the
corrupted log file and the cleared log was restarted.

80035 An error has occurred in the initialization of the It is recommended to save the backups or to delete
logs. An attempt has been made to create backups | them in order to release memory.
of the tables and this has failed. No logging or
backup has been performed.

80044 The export of a log was interrupted because The export resumes automatically.

Runtime was closed or due to a power failure. It
was detected that the export needed to be resume
when Runtime restarted.

80045 The export of a log was interrupted due to an error | The export is repeated automatically. Check:
in the connection to the server or at the server e The connection to the server.
itself. e [f the server is running.

o |f there is enough free space on the server.

80046 The destination file could not be written while Check whether there is enough space on the server

exporting the log.

and it you have permission to create the log file.
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80047 The log could not be read while exporting it. Check whether the storage medium is correctly
inserted.
80049 The log could not be renamed while preparing to Check whether the storage medium is correctly
export it. inserted and if there is sufficient space on the medium.
The job can not be completed."
80050 The log which shall be exported is not closed. Make sure the "CloseAll Logs" system function is
The job can not be completed. called before using the "ExportLog" system function.
Change the configuration as required.

Table 8-9 90000 - FDA alarms

Number Effect/causes Remedy

90024 No operator actions can be logged due to lack of Make more space available by inserting an empty
space on the storage medium for log. The operator | storage medium or swapping out the log files on the
action will therefore not be executed. server using "ExportLog".

90025 No user actions can be logged because of error Check whether the storage medium is correctly
state of the archive. Therefore the user action will | inserted.
not be executed.

90026 No operator actions can be logged because the log | Before further operator actions are carried out, the log
is closed. The operator action will therefore not be | must be opened again using the system function
executed. "OpenAllLogs". Change the configuration as required.

90028 The password you entered is incorrect. Enter the correct password.

90029 Runtime was closed during ongoing operation Ensure that you are using the correct storage medium.

(perhaps due to a power failure) or a storage
medium in use is incompatible with Audit Trail. An
Audit Trail is not suitable if it belongs to another
project or has already be archived.

90030 Runtime was closed during ongoing operation --
(perhaps due to a power failure).
90031 Runtime was closed during ongoing operation --
(perhaps due to a power failure).
90032 Running out of space on the storage medium for Make more space available by inserting an empty
log. storage medium or swapping out the log files on the
server using "ExportLog".
90033 No more space on the storage medium for log. As | Make more space available by inserting an empty
of now, no more operator actions requiring logging | storage medium or swapping out the log files on the
will be executed. server using "ExportLog".
90039 You do not have the necessary authorization to Adapt or upgrade your authorizations.
perform this action.
90040 Audit Trail is switched off because of a forced user | Activate the "Audit Trail" again using the system
action. function "StartLog".
90041 A user action which has to be logged has been A user action requiring logging should only be possible
executed without a logged on user. with permission. Change the configuration by setting a
required permission for the input object.
90044 A user action which has to be confirmed was Repeat the user action if necessary.
blocked, because there is another user action
pending.
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Table 8-10 110000 - Offline function alarms

Number Effect/causes Remedy

110000 The operating mode was changed. "Offline" mode | --
is now set.

110001 The operating mode was changed. "Online" mode | --
is now set.

110002 The operating mode was not changed. Check the connection to the PLCs.

Check whether the address area for the area pointer 88
“Coordination" in the PLC is available.

110003 The operating mode of the specified PLC was --
changed by the system function
"SetConnectionMode".

The operating mode is now "offline".

110004 The operating mode of the specified PLC has been | --
changed by the system function
"SetConnectionMode".

The operating mode is now "online".

110005 An attempt was made to use the system function Switch the complete system to "online" mode, then
SetConnectionMode to switch the specified PLC to | execute the system function again.

"online" mode, although the entire system is in
"offline" mode. This changeover is not allowed.
The PLC remains in "offline" mode.

110006 The content of the "project version" area pointer Check:
does not match the user version configured in e The project ID entered on the PLC.

WinCC flexible. WinCC flexible Runtime is « The project ID entered in WinCC flexible.
therefore closed.
Table 8-11 120000 - Trend alarms

Number Effect/causes Remedy

120000 The trend is not displayed because you configured | Change the configuration.
an incorrect axis to the trend or an incorrect trend.

120001 The trend is not displayed because you configured | Change the configuration.
an incorrect axis to the trend or an incorrect trend.

120002 The trend is not displayed because the tag Check whether the data area for the tag exists in the
assigned attempts to access an invalid PLC PLC, the configured address is correct and the value
address. range for the tag is correct.

Table 8-12 130000 - System information alarms

Number Effect/causes Remedy

130000 The action was not executed. Close all other programs.

Delete files no longer required from the hard disk.

130001 The action was not executed. Delete files no longer required from the hard disk.

130002 The action was not executed. Close all other programs.

Delete files no longer required from the hard disk.
WinCC flexible 2008 Runtime
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130003 No data medium found. The operation is canceled. | Check, for example, if
e The correct data medium is being accessed
e The data medium is inserted

130004 The data medium is write-protected. The operation | Check whether access has been made to the correct

is canceled. data carrier. Remove the write protection.

130005 The file is read only. The operation is canceled. Check whether access has been made to the correct
file. Edit the file attributes if necessary.

130006 Access to file failed. The operation is canceled. Check, for example, if
e The correct file is being accessed
e The file exists
¢ Another action is preventing simultaneous access to

the file.

130007 The network connection is interrupted. Check the network connection and eliminate the cause

Records cannot be saved or read over the network | of error.
connection.
130008 The storage card is not available. Insert the storage card.
Records cannot be saved to / read from the
storage card.

130009 The specified folder does not exist on the storage | Insert the storage card.

card.
Any files saved to this directory are not backed up
when you switch off the HMI device.
130010 The maximum nesting depth can be exhausted Check the configuration.
when, for example, a value change in a script
results in the call of another script and the second
script in turn has a value change that results in the
call of yet a further script etc.
The configured functionality is not supported.
Table 8-13 140000 - Connection alarms chns7: Connection + device

Number Effect/causes Remedy

140000 An online connection to the PLC is established. --

140001 The online connection to the PLC was shut down. | --

140003 No tag updating or writing is executed. Check the connection and if the PLC is switched on.
Check the parameter definitions in the Control Panel
using "Set PG/PC interface".

Restart the system.
140004 No tag update or write operations are executed Verify the connection and check whether the PLC is

because the access point or the module
configuration is faulty.

switched on.

Check the access point or the module configuration
(MPI, PPI, PROFIBUS) in the Control Panel with "Set
PG/PC interface".

Restart the system.
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140005 No tag updating or writing is executed because the | Use a different HMI device address.
HMI device address is incorrect (possibly too high). | Verify the connection and check whether the PLC is
switched on.
Check the parameter definitions in the Control Panel
using "Set PG/PC interface".
Restart the system.
140006 No tag updating or writing is executed because the | Select a different baud rate in WinCC flexible
baud rate is incorrect. (according to module, profile, communication peer,
etc.).
140007 Tags are not updated or written because the bus Check the user-defined bus profile.
profile is incorrect (see %1). Check the connection and if the PLC is switched on.
The following parameters could not be written to Check the parameter definitions in the Control Panel
the registry: using "Set PG/PC interface".
1: Tslot Restart the system.
2: Tqui
3: Tset
4: MinTsdr
5: MaxTsdr
6: Trdy
7: Tid1
8: Tid2
9: Gap Factor
10: Retry Limit
140008 No tag updating or writing is executed because Check the connection and if the PLC is switched on.
baud rate is incorrect. The following parameters Check the parameter definitions in the Control Panel
could not be written to the registry: using "Set PG/PC interface".
0: General error Restart the system.
1: Wrong version
2: Profile cannot be written to the registry.
3: The subnet type cannot be written to the
registry.
4: The Target Rotation Time cannot be written to
the registry.
5: Faulty Highest Address (HSA).
140009 Tags are not updated or written because the Reinstall the module in the Control Panel using "Set
module for S7 communication was not found. PG/PC interface".
140010 No S7 communication partner found because the | Switch the PLC on.
PLC is shut down. DP/T:
DP/T: If only one master is connected to the network, disable
The option “PG/PC is the only master” is not setin | "PG/PC is the only master" in "Set PG/PC interface".
the Control Panel under “Set PG/PC interface.” If several masters are connected to the network, enable
these. Do not change any settings, for this will cause
bus errors.
140011 No tag updating or writing is executed because Check the connection and that the communication
communication is down. partner is switched on.
140012 There is an initialization problem (e.g. when Restart the HMI device.

WinCC flexible Runtime was closed in Task
Manager).

Or:

Another application (e.g.STEP7) with different bus
parameters is active and the driver cannot be
started with the new bus parameters (transmission
rate, for example).

Or:
Run WinCC flexible Runtime, then start your other
applications.
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140013 The MPI cable is disconnected and, thus, there is | Check the connections.
no power supply.

140014 The configured bus address is in already in use by | Edit the HMI device address in the PLC configuration.
another application.

140015 Wrong transmission rate Correct the relevant parameters.

Or:

Faulty bus parameters (e.g. HSA)

Or:

OP address > HSA or: Wrong interrupt vector
(interrupt does not arrive at the driver)

140016 The hardware does not support the configured Change the interrupt number.
interrupt.

140017 The set interrupt is in use by another driver. Change the interrupt number.

140018 The consistency check was disabled by Enable the consistency check with SIMOTION Scout
SIMOTION Scout. Only a corresponding note and once again download the project to the PLC.
appears.

140019 SIMOTION Scout is downloading a new project to | Wait until the end of the reconfiguration.
the PLC. Connection to the PLC is canceled.

140020 The version in the PLC and that of the project The following remedies are available:
(FWXfile) do not match. Download the current version to the PLC using
Connection to the PLC is canceled. SIMOTION Scout.

Regenerate the project using WinCC flexible ES, close
WinCC flexible Runtime and restart with a new
configuration.

Table 8-14 150000 - Connection alarms chnAS511: Connection

Number Effect/causes Remedy

150000 No more data is read or written. Possible causes: | Ensure that the cable is plugged in, the PLC is
e The cable is defective. operational, the correct port is being used.

« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.
e The wrong port is used for the connection.
e System overload

150001 Connection is up because the cause of the --
interruption has been eliminated.

Table 8-15 160000 - Connection alarms IVar (WinLC) / OPC: Connection

Number Effect/causes Remedy

160000 No more data is read or written. Possible causes: | Ensure that the cable is plugged in, the PLC is
e The cable is defective. operational, the correct port is being used.
« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.
e The wrong port is used for the connection.
e System overload

160001 Connection is up because the cause of the --

interruption has been eliminated.
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160010

No connection to the server because the server
identification (CLS-ID) cannot be determined.
Values cannot be read or written.

Check access rights.

160011

No connection to the server because the server
identification (CLS-ID) cannot be determined.
Values cannot be read or written.

Check, for example, if

e The server name is correct.

e The computer name is correct.
e The server is registered.

160012

No connection to the server because the server
identification (CLS-ID) cannot be determined.
Values cannot be read or written.

Check, for example, if

e The server name is correct.

e The computer name is correct.
e The server is registered.

Note for advanced users:
Interpret the value from HRESULT.

160013

The specified server was started as InProc server.
This has not been released and may possibly lead
to incorrect behavior because the server is running
in the same process area as the WinCC flexible
Runtime software.

Configure the server as OutProc Server or Local
Server.

160014

Only one OPC server project can be started on a
PC/MP. An alarm is output when an attempt is
made to start a second project.

The second project has no OPC server
functionality and cannot be located as an OPC
server by external sources.

Do not start a second project with OPC server
functionality on the computer.

Table 8-16

170000 - S7 dialog alarms

Number

Effect/causes

Remedy

170000

S7 diagnostics events are not indicated because it
is not possible to log on to the S7 diagnostics
functions at this device. The service is not
supported.

170001

The S7 diagnostics buffer cannot be viewed
because communication with the PLC is shut
down.

Set the PLC to online mode.

170002

The S7 diagnostics buffer cannot be viewed
because reading of the diagnostics buffer (SSL)
was canceled with error.

170003

An S7 diagnostics event cannot be visualized. The
system returns internal error %2.

170004

An S7 diagnostics event cannot be visualized. The
system returns an internal error of error class %2,
error number %3.

170007

It is not possible to read the S7 diagnostics buffer
(SSL) because this operation was canceled with an
internal error of class %2 and error code %3.
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Table 8-17 180000 - Misc/common alarms

Number Effect/causes Remedy

180000 A component/OCX received configuration data with | Install a newer component.
a version ID which is not supported.

180001 System overload because too many actions Several remedies are available:
running in parallel. Not all the actions can be o Generate the alarms at a slower rate (polling).
executed, some are rejected. e Initiate scripts and functions at greater intervals.

If the alarm appears more frequently:
Restart the HMI device.

180002 The screen keyboard could not be activated. Reinstall WinCC flexible Runtime.
Possible causes:
"TouchlnputPC.exe" was not registered due to a
faulty Setup.

Table 8-18 190000 - Tag alarms

Number Effect/causes Remedy

190000 It is possible that the tag is not updated. -

190001 The tag is updated after the cause of the last error | --
state has been eliminated (return to normal
operation).

190002 The tag is not updated because communication Select the system function "SetOnline" to go online.
with the PLC is down.

190004 The tag is not updated because the configured tag | Check the configuration.
address does not exist.

190005 The tag is not updated because the configured Check the configuration.
PLC type does not exist for this tag.

190006 The tag is not updated because it is not possible to | Check the configuration.
map the PLC type in the data type of the tag.

190007 The tag value is not modified because the Set online mode or reconnect to the PLC.
connection to the PLC is interrupted or the tag is
offline.

190008 The threshold values configured for the tag have Observe the configured or current threshold values of
been violated, for example, by the tag.
e A value entered
e A system function
o A script

190009 An attempt has been made to assign the tag a Observe the range of values for the data type of the
value which is outside the permitted range of tags.
values for this data type.
For example, a value of 260 was entered for a byte
tag or a value of -3 for an unsigned word tag.

190010 Too many values are written to the tag (for The following remedies are available:

example, in a loop triggered by a script).
Values are lost because only up to 100 actions are
saved to the buffer.

¢ Increase the time interval between multiple write
actions.

¢ Do not use an array tag longer than 6 words when
you configure an acknowledgment on the HMI
device using "Acknowledgment HMI".
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190011

Possible cause 1:

The value entered could not be written to the
configured PLC tag because the high or low limit
was exceeded.

The system discards the entry and restores the
original value.

Possible cause 2:
The connection to the PLC was interrupted.

Make sure that the value entered lies within the range
of values of the control tags.

Check the connection to the PLC.

190012

It is not possible to convert a value from a source
format to a target format, for example:

An attempt is being made to assign a value to a
counter that is outside the valid, PLC-specific value
range.

A tag of the type Integer should be assigned a
value of the type String.

Check the range of values or the data type of the tags.

190013

The user has entered a string that is longer than
the tag. The string is automatically shortened to the
permitted length.

Only enter strings that do not exceed the permitted tag
length.

Table 8-19

190100 - Area pointer alarms

Number

Effect/causes

Remedy

190100

The area pointer is not updated because the
address configured for this pointer does not exist.
Type

Warnings

Errors

PLC acknowledgment

HMI device acknowledgment

LED mapping

Trend request

Trend transfer 1

Trend transfer 2

No.:

Consecutive number displayed in WinCC flexible
ES.

ONO O~ WN -

Check the configuration.

190101

The area pointer is not updated because it is not
possible to map the PLC type to the area pointer
type.

Parameter type and no.:

see alarm 190100

190102

The area pointer is updated after the cause of the
last error state has been eliminated (return to
normal operation). Parameter type and no.: See
alarm 190100.
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Table 8-20 200000 - PLC coordination alarms
Number Effect/causes Remedy
200000 Coordination is not executed because the address | Change the address or set up the address in the PLC.
configured in the PLC does not exist/is not set.
200001 Coordination is canceled because the write access | Change the address or set the address in the PLC at an
to the address configured in the PLC is not area which allows write access.
possible.
200002 Coordination is not carried out at the moment Internal error
because the address format of the area pointer
does not match the internal storage format.
200003 Coordination can be executed again because the | --
last error state is eliminated (return to normal
operation).
200004 The coordination may not be executed. -
200005 No more data is read or written. Possible causes: | Ensure that the cable is plugged in and the PLC is
e The cable is defective. operational. . .
« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.
e System overload
Table 8-21 200100 - PLC user version alarms
Number Effect/causes Remedy
200100 Coordination is not executed because the Change the address or set up the address in the
address configured in the PLC does not exist/is | PLC.
not set.
200101 Coordination is canceled because the write Change the address or set the address in the PLC at
access to the address configured in the PLC is | an area which allows write access.
not possible.
200102 Coordination is not carried out at the moment Internal error
because the address format of the area pointer
does not match the internal storage format.
200103 Coordination can be executed again because -
the last error state is eliminated (return to
normal operation).
200104 The coordination may not be executed. --
200105 No more data is read or written. Possible Ensure that the cable is plugged in and the PLC is
causes: operational.
e The cable is defective. Restart the system if the system alarm persists.

e The PLC does not respond, is defective,
etc.

e System overload
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Table 8-22 210000 - PLC job alarms

Number Effect/causes Remedy

210000 Jobs are not processed because the address Change the address or set up the address in the
configured in the PLC does not exist/has not PLC.
been set up.

210001 Jobs are not processed because read/write Change the address or set up the address in the
access to the address configured in the PLC is | PLC in an area which allows read/write access.
not possible.

210002 Jobs are not executed because the address Internal error
format of the area pointer does not match the
internal storage format.

210003 The job buffer is processed again because the | --
last error status has been eliminated (return to
normal operation).

210004 It is possible that the job buffer will not be --
processed.

210005 A control request with an illegal number was Check the PLC program.
initiated.

210006 An error occurred while attempting to execute Check the parameters of the control request.
the control request. As a result, the control Recompile the configuration.
request is not executed. Observe the
next/previous system alarms.

Table 8-23 220000 - WinCC channel adapter alarms

Number Effect/causes Remedy

220001 The tag is not downloaded because the Change the configuration.
associated communication driver / HMI device
does not support the download of
Boolean/discrete data types.

220002 The tag is not downloaded because the Change the configuration.
associated communication driver / HMI device
does not support write access to the data type
BYTE.

220003 The communication driver cannot be loaded. Install the driver by reinstalling WinCC flexible
The driver may not be installed. Runtime.

220004 Communication is down and no update data is | Check the connection.
transferred because the cable is not connected
or defective etc.

220005 Communication is up. --

220006 The connection between the specified PLC and | --
the specified port is active.

220007 The connection to the specified PLC is Check whether

interrupted at the specified port.

e The cable is plugged in
e The PLCis OK
e The correct port is used

e Your configuration is OK (port parameters,
protocol settings, PLC address).

Restart the system if the system alarm persists.
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Effect/causes

Remedy

220008

The communication driver cannot access or
open the specified port. The port may be in use
by another application or the port used is not
available on the destination device.

There is no communication with the PLC.

Close all the applications which access this port and
restart the computer.
Use another port of the system.

Table 8-24

230000 - View alarms

Number

Effect/causes

Remedy

230000

The value entered could not be accepted. The
system discards the entry and restores the
previous value.

Either

e The value range has been exceeded

¢ lllegal characters have been entered

e The maximum permitted number of users
has been exceeded.

Enter a practical value or delete any unneeded
users.

230002

The currently logged in user has not the
required authorization. The system therefore
discards the input and restored the previous
value.

Log on as a user with appropriate authorization.

230003

Changeover to the specified screen failed
because the screen is not available/configured.
The current screen remains selected.

Configure the screen and check the screen selection
function.

230005

The value range of the tag has been exceeded
in the 1/0 field.
The original value of the tag is retained.

Observe the range of values for the tag when
entering a value.

230100

During navigation in the web browser, the
system returned a message which may be of
interest to the user.

The web browser continues to run but may not
(fully) show the new page.

Navigate to another page.

230200

The connection to the HTTP channel was
interrupted due to an error. This error is
explained in detail by another system alarm.
Data is no longer exchanged.

Check the network connection.
Check the server configuration.

230201

The connection to HTTP channel was
established.
Data is exchanged.
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230202 WININET.DLL has detected an error. This error | Depending on the cause:
is usually generated if it is not possible to When an attempt to connect fails or a timeout error
connect to the server or if the server denies occurs:
access _becagse the client could not e Check the network connection and the network.
authenticate itself.
A rejected server certificate could also cause a | ® Check the server address.
communication error in secure SSL e Check whether the WebServer is actually running
connections. on the destination station.
For details, refer to the error text in the alarm. Faulty authorization:
This text is always output in the language of e The configured user name and/or password do
your Windows installation, as it is returned by not match those on the server. Establish
the Windows operating system. consistency
%r]ocesz V?Itt;]es allre notﬁxihangfd. dbv th When the server certificate is rejected:
'€ part of the alarm which IS returned by the Certificate signed by an unknown CA ( ):
Windows operating system may not be . . . ) .
displayed, for example "An error has occurred.” | ® Either ignore this item in your project, or
WININET.DLL returns the following error: o Install a certificate that has been signed with a
Number: 12055 Text:HTTP: <no error text root certificate known to the client computer.
available>." The date of the certificate is invalid:
e Either ignore this item in your project, or
o |Install a certificate with a valid date on the server.
Invalid CN (Common Name or Computer Name):
o Either ignore this item in your project, or
e Install a certificate with a name that corresponds
to that of the server address.
230203 Although a connection can be made to the Error 503 Service unavailable:
server, the HTTP server refuses to connect Check that WinCC flexible Runtime is running on the
because server and the HTTP channel is supported.
¢ WinCC flexible Runtime is not running on
the server, or
e The HTTP channel is not supported (503
Service unavailable).
Other errors can only occur if the Webserver
does not support the HTTP channel. The
language of the alarm text depends on the
Webserver.
Data is not exchanged.
230301 An internal error has occurred. An English text | --
explains the error in more detail. This may be
caused by insufficient memory.
OCX does not work.
230302 The name of the remote server cannot be Check the configured server address.
resolved. Check whether the DNS service is available on the
The attempt to connect failed. network.
230303 The remote server is not running on the Check the configured server address.
addressed computer. Check whether the remote server is running on the
Wrong server address. target computer.
The attempt to connect failed.
230304 The remote server on the addressed computer | Use a compatible remote server.

is incompatible with VNCOCX.
The attempt to connect failed.
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230305 The authentication has failed because the Configure the correct password.
password is incorrect.
The attempt to connect failed.

230306 Error in the connection to the remote server. Check whether
This may occur as a result of network problems. | ¢ The bus cable is plugged in
The attempt to connect failed. « There are network problems.

230307 The connection to the remote server was shut | --
down because
e The remote server was shut down, or
e The user instructed the server to close all

connections.

The connection is closed.

230308 This alarm provides information on the --
connection status.
An attempt is made to connect.

Table 8-25 240000 - Authorization alarms

Number Effect/causes Remedy

240000 WinCC flexible Runtime is operating in demo Install the authorization.
mode.
You have no authorization or your authorization
is corrupted.

240001 WinCC flexible Runtime is operating in demo Load an adequate authorization / powerpack.
mode.
Too many tags are configured for the installed
version.

240002 WiInCC flexible Runtime is operating with a Restore the full authorization.
time-limited emergency authorization.

240004 Error while reading the emergency Restart WinCC flexible Runtime, install the
authorization. authorization or repair the authorization (see
WinCC flexible Runtime is operating in demo Commissioning Instructions Software Protection).
mode.

240005 The Automation License Manager has detected | Reboot the HMI device or PC. If this does not solve
an internal system fault. the problem, remove the Automation License
Possible causes: Manager and install it again.
e A corrupt file
o A defective installation
e No free space for the Automation License

Manager etc.
Table 8-26 250000 - S7 Force alarms
Number Effect/causes Remedy
250000 The tag in the specified line in "Status Force" is | Check the set address and then verify that the

not updated because the address configured for
this tag is not available.

address is set up in the PLC.
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250001 The tag in the specified line in "Status Force" is | Check the set address.
not updated because the PLC type configured
for this tag does not exist.

250002 The tag in the specified line in "Status Force" is | Check the set address.
not updated because it is not possible to map
the PLC type in the tag type.

250003 An attempt to connect to the PLC failed. The Check the connection to the PLC. Check that the
tags are not updated. PLC is switched on and is online.

Table 8-27 260000 - Password system alarms

Number Effect/causes Remedy

260000 An unknown user or an unknown password has | Log on to the system as a user with a valid
been entered in the system. password.

The current user is logged off from the system.

260001 The logged in user does not have sufficient Log on to the system as a user with sufficient
authorization to execute the protected functions | authorization.
on the system.

260002 This alarm is triggered by the system function -

"TrackUserChange".

260003 The user has logged off from the system. --

260004 The user name entered into the user view Select another user name because user names have
already exists in the user management. to be unique in the user management.

260005 The entry is discarded. Enter a shorter user name.

260006 The entry is discarded. Use a shorter or longer password.

260007 The logon timeout value entered is outside the | Enter a logon timeout value between 0 and 60
valid range of 0 to 60 minutes. minutes.

The new value is discarded and the original
value is retained.

260008 An attempt was made to read a PTProRun.pwl | --
file created with ProTool V 6.0 in WinCC
flexible.

Reading the file was canceled due to
incompatibility of the format.

260009 You have attempted to delete the user "Admin" | If you need to delete a user, because perhaps you
or "PLC User". These users are fixed have exceeded the maximum number permitted,
components of the user management and delete another user.
cannot be deleted.

260012 The passwords entered in the "Change You have to log on to the system again. Then enter
Password" dialog and the confirmation field are | the identical password twice to be able to change the
not identical. password.

The password has not been changed. User will
be logged off.
260013 The password entered in the "Change You have to log on to the system again. Then enter

Password" dialog is invalid because it is already
in use.

The password has not been changed. User will
be logged off.

a new password that has not been used before.
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260014 You have tried unsuccessfully to log on three You can log on to the system with your correct
times in succession. password. Only an administrator can change the
You will be locked out and assigned to group assignment to a group.
no. 0.

260023 The password you entered does not meet the Enter a password that contains at least one number.
necessary security guidelines.

260024 The password you entered does not meet the Enter a password that contains at least one
necessary security guidelines. character.

260025 The password you entered does not meet the Enter a password that contains at least one special
necessary security guidelines. character.

260028 Upon system start-up, an attempt to log on, or | Check the connection to the SIMATIC Logon Server
when trying to change the password of a and its configuration; for example:

SIMATIC log-on user, the system attempts to 1. Port number
access the SIMATIC Logon Server.
) ) 2. IP address
If attempting to log on, the new user is not 3s
logged in. If a different user was logged on : erve'r hame
before, then this user is logged off. 4. Functional transfer cable
Or use a local user.

260029 The SIMATIC Logon user is not associated to | Check the user data on the SIMATIC Logon Server
any or several groups. and the configuration in your WinCC flexible project.
The new user is not logged in. If a different user | A user may only be assigned to one group.
was logged on before, then this user is logged
off.

260030 The SIMATIC Logon user could not change his | Log in again and choose a different password.
password on the SIMATIC Logon Server. The | Check the password rules on the SIMATIC Logon
new password may not comply with the Server.
password regulations on the server or the user
does not have the right to change his password.

The old password remains and the user is
logged off.

260031 It was not possible to log the user on to the Try again. If necessary, check the password data on
SIMATIC Logon Server. The user name or the | the SIMATIC Logon Server.
password could be incorrect or the user does
not have sufficient rights to log on.

The new user is not logged in. If a different user
was logged on before, then this user is logged
off.

260032 It was not possible to log the user on to the Check the user data on the SIMATIC Logon Server.
SIMATIC Logon Server as his account is
blocked.

The new user is not logged in. If a different user
was logged on before, then this user is logged
off.
260033 The action change password or log on user Check the connection to the SIMATIC Logon Server

could not be carried out.

and its configuration; for example:
1. Port number

2. IP address

3. Server name

4. Functional transfer cable

Or use a local user.
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260034

The last logon operation has not yet ended. A
user action or a logon dialog can therefore not
be called.

The logon dialog is not opened. The user action
is not executed.

Wait until the logon operation is complete.

260035

The last attempt to change the password was
not completed. A user action or a logon dialog
can therefore not be called.

The logon dialog is not opened. The user action
is not executed.

Wait until the procedure is complete.

260036

There are insufficient licenses on the SIMATIC
Logon Sever. The logon is not authorized.

Check the licensing on the SIMATIC Logon Server.

260037

There is no license on the SIMATIC Logon
Sever. A logon is not possible.

It is not possible to log on via the SIMATIC
Logon Server, only via a local user.

Check the licensing on the SIMATIC Logon Server.

260040

The system attempts to access the SIMATIC
Logon Server upon system start-up or when
trying to change the password.

If attempting to log on, the new user is not
logged in. If a different user was logged on
before, then this user is logged off.

Check connection to the domain and its
configuration in the Runtime security settings editor.

Or use a local user.

Table 8-28

270000 - System alarms

Number

Effect/causes

Remedy

270000

A tag is not indicated in the alarm because it
attempts to access an invalid address in the
PLC.

Check whether the data area for the tag exists in the
PLC, the configured address is correct and the value
range for the tag is correct.

270001

There is a device-specific limit as to how many
alarms may be queued for output (see the
operating instructions). This limit has been
exceeded.

The view no longer contains all the alarms.
However, all alarms are written to the alarm
buffer.

270002

The view shows alarms of a log for which there
is no data in the current project.
Wildcards are output for the alarms.

Delete older log data if necessary.

270003

The service cannot be set up because too
many devices want to use this service.

A maximum of four devices may execute this
action.

Reduce the number of HMI devices which want to
use the service.

270004

Access to persistent buffer is not possible.
Alarms cannot be restored or saved.

If the problems persist at the next startup, contact
Customer Support (delete Flash).

270005

Persistent buffer damaged: Alarms cannot be
restored.

If the problems persist at the next startup, contact
Customer Support (delete Flash).
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270006 Project modified: Alarms cannot be restored The project was generated and transferred new to
from the persistent buffer. the HMI device; The error should no longer occur
when the device starts again.
270007 A configuration problem is preventing the Update the operating system and then transfer your
restore (a DLL is missing, a directory is project again to the HMI device.
unknown, etc.).
Table 8-29 280000 - DPHMI alarms Connection
Number Effect/causes Remedy
280000 Connection is up because the cause of the --
interruption has been eliminated.
280001 No more data is read or written. Possible Check whether
causes: e The cable is plugged in
e The cable is defective e The PLCis OK
e The PLC does not respond, is defective, e The correct port is used.
ete. ) ) Restart the system if the system alarm persists.
e The wrong port is used for the connection
e System overload
280002 The connection used requires a function block | --
in the PLC.
The function block has responded.
Communication is now enabled.
280003 The connection used requires a function block | Check whether
in the PLC. e The cable is plugged in
The function block has not responded. e The PLC is OK
e The correct port is used.
Restart the system if the system alarm persists.
Remedy depends on the error code:
1: The function block must set the COM bit in the
response container.
2: The function block must not set the ERROR bit in
the response container.
3: The function block must respond within the
specified time (timeout).
4: Go online to the PLC.
280004 The connection to the PLC is interrupted. There | Check the connection parameters in WinCC flexible.

is no data exchange at present.

Ensure that the cable is plugged in, the PLC is
operational, the correct port is being used.
Restart the system if the system alarm persists.
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Table 8-30

290000 - Recipe system alarms

Number

Effect/causes

Remedy

290000

The recipe tag could not be read or written. It is
assigned the start value.

The alarm can be entered in the alarm buffer for
up to four more failed tags if necessary. After
that, alarm 290003 is output.

Check in the configuration that the address has been
set up in the PLC.

290001

An attempt has been made to assign a value to
a recipe tag which is outside the value range
permitted for this type.

The alarm can be entered in the alarm buffer for
up to four more failed tags if necessary. After
that, alarm 290004 is output.

Observe the value range for the tag type.

290002

It is not possible to convert a value from a
source format to a target format.

The alarm can be entered in the alarm buffer for
up to four more failed recipe tags if necessary.
After that, alarm 290005 is output.

Check the value range or type of the tag.

290003

This alarm is output when alarm number
290000 is triggered more than five times.
In this case, no further separate alarms are
generated.

Check in the configuration that the tag addresses
have been set up in the PLC.

290004

This alarm is output when alarm number
290001 is triggered more than five times.
In this case, no further separate alarms are
generated.

Observe the value range for the tag type.

290005

This alarm is output when alarm number
290002 is triggered more than five times.
In this case, no further separate alarms are
generated.

Check the value range or type of the tag.

290006

The threshold values configured for the tag
have been violated by values entered.

Observe the configured or current threshold values
of the tag.

290007

There is a difference between the source and
target structure of the recipe currently being
processed. The target structure contains an
additional data recipe tag which is not available
in the source structure.

The data recipe tag specified is assigned its
start value.

Insert the specified data recipe tag in the source
structure.

290008

There is a difference between the source and
target structure of the recipe currently being
processed. The source structure contains an
additional data recipe tag which is not available
in the target structure and therefore cannot be
assigned.

The value is rejected.

Remove the specified data recipe tag in the specified
recipe from the project.

290010

The storage location configured for the recipe is
not permitted.

Possible causes:

lllegal characters, write protection, data carrier
out of space or does not exist.

Check the configured storage location.

290011

The record with the specified number does not
exist.

Check the source for the number (constant or tag
value).
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290012 The recipe with the specified number does not | Check the source for the number (constant or tag
exist. value).
290013 An attempt was made to save a record under a | The following remedies are available:
record number which already exists. e Check the source for the number (constant or tag
The action is not executed. value).
e First, delete the record.
e Change the "Overwrite" function parameter.
290014 The file specified to be imported could not be Check:
found. e The file name
e Ensure that the file is in the specified directory.
290020 Alarm reporting that the download of records --
from the HMI device to the PLC has started.
290021 Alarm reporting that the download of records --
from the HMI device to the PLC was completed.
290022 Alarm reporting that the download of records Check in the configuration whether:
from the HMI device to the PLC was canceled |4 The tag addresses are configured in the PLC
due to an error. e The recipe number exists
e The record number exist
e The "Overwrite" function parameter is set
290023 Alarm reporting that the download of records --
from the PLC to the HMI device has started.
290024 Alarm reporting that the download of records -
from the PLC to the HMI device was completed.
290025 Alarm reporting that the download of records Check in the configuration whether:
due to an error. e The recipe number exists
e The record number exist
e The "Overwrite" function parameter is set
290026 An attempt has been made to read/write a Set the record status to zero.
record although the record is not free at
present.
This error may occur in the case of recipes for
which downloading with synchronization has
been configured.
290027 Unable to connect to the PLC at present. Asa | Check the connection to the PLC.
result, the record can neither be read nor
written.
Possible causes:
No physical connection to the PLC (no cable
plugged in, cable is defect) or the PLC is
switched off.
290030 This alarm is output after you selected screen Reload the record from the storage location or retain
which contains a recipe view in which a record | the current values.
is already selected.
290031 While saving, it was detected that a record with | Overwrite the record or cancel the action.
the specified number already exists.
290032 While exporting records it was detected that a Overwrite the file or cancel the process.
file with the specified name already exists.
290033 Confirmation request before deleting records. -
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290040

A record error with error code %1 that cannot
be described in more detail occurred.

The action is canceled.

It is possible that the record was not installed
correctly on the PLC.

Check the storage location, the record, the "Data
record" area pointer and if necessary, the connection
to the PLC.

Restart the action after a short time.

If the error persists, contact Customer Support.
Forward the relevant error code to Customer
Support.

290041

A record or file cannot be saved because the
storage location is full.

Delete files no longer required.

290042

An attempt was made to execute several recipe
actions simultaneously. The last action was not
executed.

Trigger the action again after waiting a short period.

290043

Confirmation request before storing records.

290044

The data store for the recipe has been
destroyed and is deleted.

290050

Alarm reporting that the export of records has
started.

290051

Alarm reporting that the export of records was
completed.

290052

Alarm reporting that the export of records was
canceled due to an error.

Ensure that the structure of the records at the
storage location and the current recipe structure on
the HMI device are identical.

290053

Alarm reporting that the import of records has
started.

290054

Alarm reporting that the import of records was
completed.

290055

Alarm reporting that the import of records was
canceled due to an error.

Ensure that the structure of the records at the
storage location and the current recipe structure on
the HMI device are identical.

290056

Error when reading/writing the value in the
specified line/column.
The action was canceled.

Check the specified line/column.

290057

The tags of the recipe specified were toggled
from "offline" to "online" mode.

Each change of a tag in this recipe is now
immediately downloaded to the PLC.

290058

The tags of the specified recipe were toggled
from "offline" to "online" mode.

Modifications to tags in this recipe are no longer
immediately transferred to the PLC but must be
transferred there explicitly by downloading a
record.

290059

Alarm reporting that the specified record was
saved.

290060

Alarm reporting that the specified record
memory was cleared.

290061

Alarm reporting that clearing of record memory
was canceled due to an error.

290062

The record number is above the maximum of
65536.
This record cannot be created.

Select another number.
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290063

This occurs with the system function
"ExportDataRecords" when the parameter
"Overwrite" is set to No.

An attempt has been made to save a recipe
under a file name which already exists.

The export is canceled.

Check the "ExportDataRecords" system function.

290064

Alarm reporting that the deletion of records has
started.

290065

Alarm reporting that the deletion of records has
successfully completed.

290066

Confirmation request before deleting records.

290068

Security request to confirm if all records in the
recipe should be deleted.

290069

Security request to confirm if all records in the
recipe should be deleted.

290070

The record specified is not in the import file.

Check the source of the record number or record
name (constant or tag value).

290071

During the editing of record values, a value was
entered which exceeded the low limit of the
recipe tag.

The entry is discarded.

Enter a value within the limits of the recipe tag.

290072

When editing record values, a value was
entered which exceeds the high limit of the
recipe tag.

The entry is discarded.

Enter a value within the limits of the recipe tag.

290073

An action (e.g. saving a record) failed due to an
unknown error.

The error corresponds to the status alarm
IDS_OUT_CMD_EXE_ERR in the large recipe
view.

290074

While saving, it was detected that a record with
the specified number already exists but under
another name.

Overwrite the record, change the record number or
cancel the action.

290075

A record with this name already exists.
The record is not saved.

Please select a different record name.

290110

The default values could not be set due to an
error.

290111

The Recipes subsystem cannot be used.
Recipe views have no content and recipe-
specific functions will not be performed.

Possible causes:

e An error occurred while transferring the
recipes.

e The recipe structure was changed in ES.
When the project was downloaded again,
the recipes were not transferred with it. This
means that the new configuration data is not
being transferred to the old recipes on the
device.

Transfer the project to the device again, together
with the recipes (the corresponding check box in the
Transfer dialog must be checked).
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Table 8-31 300000 - Alarm_S alarms
Number Effect/causes Remedy
300000 Faulty configuration of process monitoring (e.g. | Change the PLC configuration.
using PDiag or S7-Graph): More alarms are
queued than specified in the specifications of
the CPU. No further ALARM_S alarms can be
managed by the PLC and reported to the HMI
devices.
300001 ALARM_S is not registered on this PLC. Select a controller that supports the ALARM_S
service.
Table 8-32 310000 - Report system alarms
Number Effect/causes Remedy
310000 An attempt is being made to print too many Wait until the previous active log was printed.
reports in parallel. Repeat the print job if necessary.
Only one log file can be output to the printer at
a given time; the print job is therefore rejected.
310001 An error occurred on triggering the printer. The | Evaluate the additional system alarms related to this
report is either not printed or printed with errors. | alarm.
Repeat the print job if necessary.
Table 8-33 320000 - Alarms
Number Effect/causes Remedy
320000 The movements have already been indicated Deselect the movements on the other display units
by another device. and select the motion control screen on the required
The movements can no longer be controlled. display unit.
320001 The network is too complex. View the network in STL.
The faulty addresses cannot be indicated.
320002 No diagnosable alarm message (error) Select a diagnostics alarm from the ZP_ALARM
selected. alarm screen.
The unit associated with the alarm message
could not be selected.
320003 No alarm message (error) exists for the Select the defective unit from the overview screen.
selected unit. The detail view cannot visualize
any networks.
320004 The required signal states could not be read by | Check the consistency between the configuration on
the PLC. The faulty addresses cannot be found. | the display unit and the PLC program.
320005 The project contains ProAgent elements which | In order to run the project, install the optional
are not installed. ProAgent diagnostic functions | ProAgent package.
cannot be performed
320006 You have attempted to execute a function Check the type of the selected unit.
which is not supported in the current
constellation.
320007 No error-triggering addresses were found on Switch the detail screen to STL layout mode and
the networks. check the status of the addresses and exclusion
ProAgent cannot indicate any faulty addresses. | addresses.
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320008 The diagnostic data stored in the configuration | Transfer the project to the HMI device again.
are not synchronized with those in the PLC.
ProAgent can only indicate the diagnostic units.
320009 The diagnostic data stored in the configuration | Transfer the project to the HMI device again.
are not synchronized with those in the PLC.
The diagnostic screens can be operated as
usual.
ProAgent may be unable to show all diagnostic
texts.
320010 The diagnostic data stored in the configuration | Transfer the project to the HMI device again.
are not synchronized with those in STEP7.
The ProAgent diagnostics data is not up-to-
date.
320011 A unit with the corresponding DB number and Check the parameters of the "SelectUnit" function
FB number does not exist. and the units selected in the project.
The function cannot be executed.
320012 The "Step sequence mode" dialog is no longer | Use the ZP_STEP step sequence screen from the
supported. corresponding standard project for your project.
Instead of calling the
Overview_Step_Sequence_Mode function, call the
"FixedScreenSelection" function using ZP_STEP as
the screen name.
320014 The selected PLC cannot be evaluated for Check the parameters of the
ProAgent. "EvaluateAlarmDisplayFault" system function.
The Alarm view assigned to the
"EvaluateAlarmDisplayFault" system function
could not be found.
Table 8-34 330000 - GUI alarms
Number Effect/causes Remedy
330022 Too many dialogs are open on the HMI device. | Close all dialogs you do not require on the HMI
device.
330026 The password will expire after the number of Enter a new password.
days shown.
Table 8-35 350000 - GUI alarms
Number Effect/causes Remedy
350000 PROFIsafe packages have not arrived within Check the WLAN connection.

the necessary period.
There is a communication problem with the F-
CPU.

RT is terminated.
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350001 PROFIsafe packages have not arrived within Check the WLAN connection.
the necessary period.
There is a communication problem with the F-
CPU.
The PROFIsafe connection is re-established.
350002 An internal error has occurred. Internal error
Runtime is terminated.
350003 Feedback concerning the connection --
established with the F-CPU.
The Emergency-Off buttons are active
immediately.
350004 PROFIsafe communication was set and the --
connection was cleared.
The Runtime can be terminated.
The Emergency-Off buttons are deactivated
immediately.
350005 Incorrect address configured for the F-slave. Check and modify the address of the F slave in
No PROFIsafe connection. WinCC flexible ES.
350006 The project has started. At the start of the Press the two enabling buttons one after another in
project, the enabling buttons must be checked | the "Enable" and "Panic" positions.
for functionality.
350008 The wrong number of fail-safe buttons was Change the number of fail-safe buttons in the
configured. project.
No PROFlsafe connection.
350009 The device is in Override mode. Exit Override mode.
It may no longer be possible to detect the
location because transponder detection fails.
350010 Internal error: The device has no fail-safe Send the device back.

buttons.

Worldwide contact person
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CPU
CSv
CTS
DC

DCD
DIL

DP

DSN
DSR
DTR
ESD

EMC
EN
ES
ESD
GND
HF
HMI
IEC

LED
MMC
MOS
MPI
MS
MTBF
n. c.
OoP
PC
PG
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Central Processing Unit

Comma Separated Values

Clear To Send

Direct Current

Data Carrier Detect

Dual-in-Line (electronic chip housing design)
Distributed I/O

Data Source Name

Data Set Ready

Data Terminal Ready

Electrostatic Discharge, the components and modules endangered by
such

Electromagnetic Compatibility
European standard

Engineering System

Electrostatic Sensitive Device
Ground

High Frequency

Human Machine Interface
International Electronic Commission
Interface

Light Emitting Diode

Multi-Media Card

Metal Oxide Semiconductor
Multipoint Interface (SIMATIC S7)
Microsoft

Mean Time Between Failures

Not connected

Operator Panel

Personal Computer
Programming device
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PPI
RAM
RTS
RxD
SELV
SP
PLC
STN
Sub-D
TAB
TCP/IP
TFT
TxD
UL

Point to Point Interface (SIMATIC S7)
Random Access Memory

Request To Send

Receive Data

Safety Extra Low Voltage

Service pack

Programmable Logic Controller
Super Twisted Nematic
Subminiature D (plug)

Tabulator

Transmission Control Protocol/Internet Protocol
Thin Film Transistor

Transmit Data

Underwriter’s Laboratory
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10.1 Glossary

Plant

General term referring to machines, processing centers, systems, plants and processes
which are operated and monitored on an HMI device.

Display duration
Defines whether and how long a system alarm is displayed on the HMI device.

AG

Controller of the SIMATIC S5 series such as the AG S5-115U, for example
AS

Controller of the SIMATIC S7 series such as a SIMATIC S7-300
AS 511

Protocol of the programming device interface of a SIMATIC S5 controller

HMI device image

File which can be transferred from the programming device to the HMI device. The HMI
device image contains the operating system and elements of the runtime software required
to run a project.

Operator control object

Component of a project which is used to enter values and trigger functions. A button, for
example, is an operator control object.

"Transfer" mode

HMI device operating mode, set to transfer an executable project from the configuration
computer to the HMI device.
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Screen

Screen object

Boot loader

10 field

EMC

Event

Field

Flash memory

Softkey

Form of the visualization of all logically related process data for a plant. The visualization of
the process data can be supported by graphic objects.

Configured object for operating and monitoring the system, e.g. a rectangle, an IO field or a
recipe view.

Used to start the operating system. Automatically started when the HMI device is switched
on. A start screen appears during startup. After the operating system has been loaded, the
Loader opens.

Enables the input or output of values on the HMI device which are transferred to the
controller.

Electromagnetic compatibility is the ability of electrical equipment to function properly in its
electromagnetic environment without influencing this environment.

Functions are triggered by defined incoming events. Events can be configured. Events which
can be assigned to a button include "Press" and "Release", for example.

Area reserved in configured screens for the input and output of values.

Non-volatile memory with EEPROM chips, used as mobile storage medium or as memory
module installed permanently on the motherboard.

Key on the HMI device which supports user-specific functions. A function is assigned to the
key in the configuration. The assignment of the keys may be specific to an active screen or
not.

Half brightness lifetime
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Time period until the brightness degrades to 50% of its original value. The specified value is
dependent on the operating temperature.
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Hardcopy

Infotext

Alarm logging

10.17 Glossary

Output of the screen content to a printer.

Configured information on objects within a project. An alarm infotext, for example, may
contain information on the cause of the fault and troubleshooting routines.

Output of user-specific alarms to a printer, in parallel to their output to the HMI device
screen.

Alarm, user-specific

A user-specific alarm can be assigned to one of the following alarm classes:
® FError

e \Warning

® User-specific alarm classes

A user-specific alarm designates a certain operating status of the plant connected to the HMI
device via the controller.

Alarm, deactivated

Alarm, activated

Moment at which the initiation of an alarm is reset by the controller.

Moment at which an alarm is triggered by the controller or HMI device.

Alarm, acknowledging

Notation

Object

Acknowledgement of an alarm confirms that it has been noted.

System consisting of characters, symbols and rules. In particular used to define the write
format of a programming language in data processing.

Component of a project. Example: screen or alarm. Objects are used to view or enter texts
and values on the HMI device.
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Project

Project file

Result of a configuration using an engineering software. The project normally contains
several screens with embedded system-specific objects, basic settings and alarms. The
project file of a project configured in WinCC flexible is saved under the file name extension
*.hmi.

You distinguish between the project on the configuration computer and that on an HMI
device. A project may be available in more languages on the configuration computer than
can be managed on the HMI device. The project on the configuration computer can also be
set up for different HMI devices. Only the project set up for a particular HMI device can be
transferred to that HMI device.

File which is generated based on a source file for a specific HMI device when the
configuration is completed. The project file is transferred to the corresponding HMI device
and is used to operate and monitor plants. Refer to Source file.

Configuration computer

General term for programming devices (PGs) and PCs on which plant projects are created
using an engineering software.

Engineering software

Software for the creation of projects for process visualization — see also project, process
visualization and runtime software

Process visualization

Source file

Visualization of processes from the areas of production, logistics and services in text-based
and graphics format. Configured plant screens allow operator intervention in active plant
processes by means of the input and output data.

File from which various project files can be created, depending on the configuration. The
source file is not transferred and remains on the configuration computer.

The file name extension of a source file is *.hmi. Refer to Source file, compressed and
Project file.

Source file, compressed
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Compressed form of the source file. Can be transferred in addition to the project file to the
corresponding HMI device. "Enable Upload" must be set in the project on the configuration
computer. The file extension of a compressed source file is *.pdz. The standard memory
location for a compressed source file is the external MMC. Refer to Source file.

To restore a source file, it is necessary to use the same WinCC flexible version which was
used to configure the project.
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Recipe

Combination of tags forming a fixed data structure. The data structure configured can be
assigned data on the HMI device and is then referred to as a data record. The use of recipes
ensures that when a data record is downloaded, all the assigned data is transferred
synchronously to the controller.

Runtime software

Process visualization software which can be used to debug a project on a configuration
computer. Also refer to "Project" and "Engineering software".

Acknowledge
Acknowledging an alarm confirms that you have noted it.
STEP 7
Programming software SIMATIC S7, SIMATIC C7 and SIMATIC WinAC controllers.
STEP 7 Micro/WIN
Programming software for controllers of the SIMATIC S7-200 series.
Controller

General term for devices and systems with which the HMI device communicates, e.g.
SIMATIC S7.

Control request
Triggers a function via the controller.

Fault time
Refers to the time interval between an activated and deactivated alarm.

Symbolic 10 field

Box for the input/output of a parameter. Contains a list of default entries from which one can
be selected.

System alarms

Assigned to the "System" alarm class. A system alarm refers to internal states on the HMI
device and the controller.
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Tab order

Transfer

Tag
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In the configuration, this sets the sequence in which objects are focused on pressing the
<TAB> key.

The transfer of an executable project to the HMI device.

Defined memory location to which values can be written to and read from. This can be done
from the controller or the HMI device. Based on whether the tag is interconnected with the
controller or not, we distinguish between "external" tags (process tags) and "internal" tags.
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A

Acoustic feedback, 72
Alarm
acknowledgment, 88, 91
Calling the infotext, 92
Editing, 88, 91
In Runtime, 32
Alarm buffer
In Runtime, 33
Alarm class
In Runtime, 32
Layout, 86, 90
Alarm indicator
In Runtime, 34
Alarm Indicator, 84
Application, 84
Behavior, 84
Layout, 84
Operation, 84
Operation with the mouse, 85
Alarm log
In Runtime, 33
Scope of alarm logging, 35
Alarm view
Keyboard operation, 88
Mouse operation, 87
Alarm View, 86, 91
Alarm text window, 91
Application, 86
Layout, 86, 90
Operation, 86, 91
Operator control, 87
Alarm window
In Runtime, 34
Alarm Window, 86
Application, 86
Operation, 86
Operator control, 87
Alt layer
Screen keyboard, 73
Application
Alarm Indicator, 84
Alarm View, 86
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Alarm Window, 86

Button, 76

Date/time field, 101

Graphic 10 field, 81

I/O field, 79

Recipe view, 92

Simple alarm view, 89

Simple alarm window, 89

Simple user view, 105

Slider, 99

Sm@rtClient view, 112

Status Force, 108

Switch, 77

Symbol, 115

Symbolic 10 field, 83

Trend view, 97

User view, 103

User view, 102
Application example

Entering recipe data offline, 44

Recipe with manual production sequence, 45
Authorization

In Runtime, 63

B

Behavior
Alarm Indicator, 84
Button, 76
Date/time field, 101
Graphic 10 field, 82
HTML Browser, 110
I/O field, 80
Simple recipe view, 95
Sm@rtClient view, 114
Switch, 78
Symbol, 115
Symbolic 10 field, 83
Button, 76
Application, [76
Behavior, 76
Layout, 76
Operation, 76
Operation with the keyboard, 77
Operation with the mouse, 77
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C

calling
Operator note: touch screen device, 75
Operator note: Touch screen device, 73
Operator note:screen keyboard, 74
Operator note:screen keyboard, 73
Operator note:system function, 75
Operator note:touch screen device, 74
Remote control, 114
Remote monitoring, 114
Changing
Recipe data record in runtime, 54, 58
closing
Remote control, 114
Closing
Remote monitoring, 114
Runtime, 30
Control element
HTML Browser, 110
Status Force, 109
Trend view, 98
Copy
Recipe data record in runtime, 54
Recipe data record in Runtime, 58
Create
Recipe data record on the HMI device, 53, 57

D

Data Flow, 40
Data log
In Runtime, 36
Data record
Exporting, 52
Importing, 52
Reading, 56, 59
Transfer, 56, 59
Data record list, 49
Date/time field, 101
Application, 101
Behavior, 101
Layout, 101
OP 73,101
OP 73micro, 101
OP 77A, 101
Operation, 101
Operation with the keyboard, 102
Operation with the mouse, 102
TP 177A, 101
TP 177micro, 101
Deleting
Recipe data record in runtime, 55, 58
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Direct key, 71

E

Element list, 49
Enhanced recipe view, 49
Entering
Alphanumeric values:touch panel, 73
Numeric values:touch panel, 74
exporting
User data, 65
Exporting
Recipe, 52
Recipe data record, 42, 52

F

Feedback

Acoustic, 72

Optical, 72

With touch operation, 72
Force

Permissions in remote operation, 113
Full-screen mode

Setting, 24
Function key

Remote control, 112
Functional scope

Dependencies, 17

WinCC flexible Runtime, 17

G

Graphic 1O field, 81
Application, 81
Behavior, 82
Operation, 82
Operation using the keyboard, 82
Operation using the mouse, 82

H
Hiding
Screen keyboard, 73, 74
HTML Browser
Behavior, 110
Connecting to the FTP server, 110
Control element, 110
File explorer, 110
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I/O field, 79
Application, 79
Behavior, 80
Changing between input fields, 80
Incorrect entry, 80
Layout, 79
Operation, 79
Import
Recipe data record, 42
importing
User data, 65
Importing
Recipe, 52
Recipe data record, 52
Input of alphanumerical values
Touch screen device, 73
Input of numerical values
Touch screen device, 74
Installation
on the PC, 21
Internal Flash
Number of files, 20
10 field
Operation with the keyboard, 81
Operation with the mouse, 80

K

Keyboard level, 73
Keyboard operation
Simple user view, 106
Keyboard operation
Alarm view, 88
Operation with the keyboard, 78
Recipe view, 104
Keys
Remote control, 112

L

Layout
Alarm Indicator, 84
Alarm View, 86, 90
Button, 76
Date/time field, 101
I/O field, 79
Simple recipe view, 94
Simple user view, 105
Slider, 100
Sm@rtClient view, 112
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Status Force, 108

Switch, 78

Trend view, 97

User view, 103
LED control, 65

Licensing

General information, (15
Load

Recipe data record in runtime, 54, 58
Log

In Runtime, 34

Memory options, 35
Logging

Scope of alarm logging, 35
Logoff time

Exporting/importing, 65

In Runtime, 64

M

Memory card

Number of files, 20
Menu command

Simple recipe view, 95
Modifying recipe structures, 60
Monitoring mode

Sm@rtClient view, 113
Mouse operation

Alarm view, 87

Simple user view, 106

User view, 104

O

Object in runtime
Overview, 31
Offices, 6
Online
Recipe tag, 44
On-screen alphanumerical keyboard, 73
On-screen numerical keyboard, 74
operating
Runtime using the keyboard, 68
Runtime with mouse, 70
Operating element
Recipe view, 93
Operating recipes
Copying a recipe data record, 54, 58
Creating recipe data records, 53, 57
Data record transfer, 56, 59
Delete recipe data record, 55, 58
Load recipe data record, 54, 58
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Modify recipe data record, 54, 58
Modifying the recipe structure, 60
Read recipe data record, 56, 59

Operation

Alarm Indicator, 84
Alarm View, 86

Alarm Window, 86
Button, 76

Date/time field, 101
Graphic 10 field, 82
I/O field, 79

Recipe view, 92
Simple alarm view, 90
Simple recipe view, 94
Simple user view, 106
Slider, 100

Status force, 109
Switch, 78

Symbol, 115
Symbolic 10 field, 83
Trend view, 97

Operation feedback, 72
Operation using the keyboard

Graphic 10 field, 82

Operation using the mouse

Graphic 10 field, 82

Operation with the keyboard

Button, 77

Date/time field, 102

10 field, 81

Recipe view, 93
Simple alarm view, 91
Slider, 100
Sm@rtClient view, 113
Status force, 109
Symbolic 10 field, 84
Trend view, 98

Operation with the mouse

Alarm Indicator, 85
Button, 77

Date/time field, 102
10 field, 80

Recipe view, 93
Simple alarm view, 91
Slider, 100
Sm@rtClient view, 113
Status force, 109
Switch, 78

Symbolic 10 field, 83
Trend view, 98

Operator control

Alarm View, 87
Alarm Window, 87
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Simple alarm view, 90
Simple recipe view, 94
Operator note

calling:screen keyboard, 73, 74

Calling:system function, 75

Calling:Touch screen device, 73, 74, 75

Optical feedback, 72

P

Password
Exporting/importing, 65
In Runtime, 64

Permission

forcing (remote operation), 113
Picture

Printing, 65
Printing

Alarms, 65

Picture, 65

Protocol, 61

Runtime, 65

Program switching
disabling for Runtime, 24
Protocol
In Runtime, 61
Printing, 61

R

Rebuild all, 28
Recipe, 38, 39
Basics, 38
Configuration option, 43
Data Flow, 40
Data record, 39
Display in Runtime, 36
Entry, 39
Exporting, 52
Importing, 52
Recipe screen, 48
Recipe view, 48
Synchronize recipe tag, 55
Recipe data
loading and saving, 41
Recipe data record
Changing, 54, 58
Copy, 54, 58

Create on the HMI device, 53, 57

Delete, 58
Deleting, 55
Exporting, 52
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Importing, 52
Importing and exporting, 42
Load, 54, 58
Synchronizing, 55
Transfer option, 40
Recipe list, 49
Recipe screen
Synchronize tags, 51
Visual machine simulation, 50
Recipe tag
Online, 44
Synchronizing, 43, 55
Recipe view, 48, 92
Application, 92
Expanded, 49
Keyboard operation, 104
Operating element, 93
Operation, 92
Operation with the keyboard, 93
Operation with the mouse, 93
Simple, 49
Updating, 49
Remote control
calling, 114
Closing, 114
Forcing permission, 113
Remote monitoring
calling, 114
Closing, 114
Representatives, 6
Root directory, 20
Runtime
Change language, 68
Operation, 67
Operation with the keyboard, 68
Operation with the mouse, 70
Task, 13

S

Safety instruction
Recipe data record in background, 49
Screen keyboard, 73
Alphanumerical, 73
Numerical, 74
Screen object
In Runtime, overview, 31
Screen saver
for Runtime, 25
Security
In Runtime, 63
Setting
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in the Runtime configuration, 24
Shift layer
Screen keyboard, 73
Shift+Alt-Gr layer
Screen keyboard, 73
Simple alarm view, 89
Application, 89
Operation, 90
Operation with the keyboard, 91
Operation with the mouse, 91
Operator control, 90
Simple alarm window
Application, 89
Simple recipe view, 49
Behavior, 95
Control object, 94
Layout, 94
Menu command, 95
Operation, 94
Simple user view, 105
Application, 105
Changing user data, 107
Keyboard operation, 106
Layout, 105
Mouse operation, 106
Operation, 106
Slider, 99
Application, 99
Layout, 100
Operation, 100
Operation with the keyboard, 100
Operation with the mouse, 100
Sm@rtClient view, 112
Application, 112
Behavior, 114
dynamic address, 113
Layout, 112
Monitoring mode, 113
Operation with the keyboard, 113
Operation with the mouse, 113
Standard layer
Screen keyboard, 73
Status force
Control element, 109
Operation, 109
Operation with the keyboard, 109
Operation with the mouse, 109
Status Force, 108
Application, 108
Layout, 108
Storage location, 20
Switch, 77
Application, 77
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Behavior, 78

Layout, 78

Operation, 78

Operation with the keyboard, 78

Operation with the mouse, 78
Symbol

Application, 115

Behavior, 115

Operation, 115
Symbolic 10 field, 83

Application, 83

Behavior, 83

Operation, 83

Operation using the keyboard, 84

Operation using the mouse, 83
Synchronize tags

in the recipe view, 51
Synchronizing

Recipe data record, 55

Recipe tag, 43
System alarm

Meaning, 117

Parameters, 117
System requirements

PC, 19

T

Time zone
Setting, 25
Training center, 6
Transferring recipe values
between HMI device and PLC, 41
Trend view, 97
Application, 97
Control element, 98
Layout, 97
Operation, 97
Operation with the keyboard, 98
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Operation with the mouse, 98

U

User data
Exporting/importing, 65
User group
In Runtime, 63
User view, 102
Application, 102, 103
Change group, 105
Changing user data, 103
Create user, 105
Export user data, 104
Import user data, 104
Layout, 103
Mouse operation, 104
Users
In Runtime, 63
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Variables
In Runtime, 34
Virus scanners, 16
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Runtime software, 13
WinCC flexible Runtime
Closing, 30
Functional scope, 17
System requirements for a PC, 19
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